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About This Release

ABOUT THIS RELEASE
This document describes the enhancements for ERDAS IMAGINE 2018 Update 1 (v16.5.1), including
IMAGINE Photogrammetry (formerly LPS Core) and ERDAS ER Mapper. Although the information in this
document is current as of the product release, see the Hexagon Geospatial Support website for the most
current version.
This release includes both enhancements and fixes. For information on fixes that were made to ERDAS
IMAGINE for this release, see the Issues Resolved section.
This document is only an overview and does not provide all the details about the product's capabilities. See
the online help and other documents provided with ERDAS IMAGINE for more information.
Update 1 for ERDAS IMAGINE 2018 is primarily aimed at improving the NNDiffuse pan sharpening technique
which was initially introduced with ERDAS IMAGINE 2018. The update provides OpenCL-based GPU
acceleration for the technique, which in some instances can result in a two orders of magnitude increase in
performance. The algorithm has also been fine-tuned to provide even better color fidelity compared to the
original Multispectral data.
In addition, there are new Operators, such as the Linear Regression operator, as well as numerous software
quality improvements.

ERDAS IMAGINE PRODUCT TIERS
ERDAS IMAGINE® performs advanced remote sensing analysis and spatial modeling to create new
information. In addition, with ERDAS IMAGINE, you can visualize your results in 2D, 3D, movies, and on
cartographic-quality map compositions. The core of the ERDAS IMAGINE product suite is engineered to
scale with your geospatial data production needs. Optional modules (add-ons) providing specialized
functionalities are also available to enhance your productivity and capabilities.
IMAGINE Essentials® is the entry-level image processing product for map creation and simple feature
collection tools. IMAGINE Essentials enables serial batch processing.
IMAGINE Advantage® enables advanced spectral processing, image registration, mosaicking and image
analysis, and change detection capabilities. IMAGINE Advantage enables parallel batch processing for
accelerated output.
IMAGINE Professional® includes a production toolset for advanced spectral, hyperspectral, and radar
processing, and spatial modeling. Includes ERDAS ER Mapper.
IMAGINE Photogrammetry maximizes productivity with state-of-the-art photogrammetric satellite and aerial
image processing algorithms.
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New Platforms

NEW PLATFORMS
ARCGIS 10.6
ERDAS IMAGINE 2018 Update 1 has been tested and declared Supported when using an installed and
licensed version of ArcGIS 10.1 through 10.6 in order to provide Geodatabase support libraries. Alternatively,
the IMAGINE Geodatabase Support component (based on ArcGIS Engine 10.5) can be installed to provide
Geodatabase support.

NEW LICENSING
ERDAS IMAGINE 2018 was delivered with version 16.5.0.11 of the Hexagon Geospatial Licensing 2018
tools. However it is strongly recommended that all ERDAS IMAGINE customers upgrade to v16.5.0.15 (or
higher). The appropriate download can be found on the Downloads section of the Hexagon Geospatial web
site:
https://download.hexagongeospatial.com/downloads/other/geospatial-license-administrator-2018
Hexagon Geospatial Licensing 2018 v16.5.0.15 is also integrated into the ERDAS IMAGINE 2018 Update 1
installer, so any computer where you install Update 1 should also have any existing installation of Hexagon
Geospatial Licensing 2018 automatically updated to v16.5.0.15. If in doubt, refer to Windows’ Add or Remove
Programs utility to determine the currently installed version.

NEW TECHNOLOGY
GPU ACCELERATION FOR THE NNDIFFUSE PAN
SHARPENING OPERATOR
The Nearest-neighbor diffusion-based (NNDiffuse) algorithm, originally developed by Sun, Chen and
Messinger at Rochester Institute of Technology, is a state of the art pan sharpening technique, which was
introduced as an Operator (and dialog) in ERDAS IMAGINE 2018 so that you can build Spatial Models
capable of deriving information from high resolution, multispectral data.
The original implementation was provided as a CPU-only computation and so could take considerable time to
complete its processing.
With Update 1 the algorithm has been re-implemented to make use of GPU acceleration via OpenCL. If an
appropriate OpenCL driver and hardware device is present, the algorithm will make use of it. If not then it will
fall back to operating on the CPU.

EXAMPLE OF OPENCL ACCELERATION
Using an HP ZBook with Intel Core i7-6820HQ CPU @ 2.70GHz, 64GB RAM, Windows 10 Pro and a Quadro
M5000M graphics card from NVIDIA Corporation, a NNDiffuse Pan Sharpening was performed. Input data
consisted of a DigitalGlobe image tile of WorldView-2 imagery in NITF format, 16-bit, 8-band. The
Multispectral was 4,096 columns by 4096 rows and the Pan was 16,384 columns by 16,384 rows.
Using the original CPU implementation provided by ERDAS IMAGINE 2018, the pan sharpening process
took just short of 17 hours (i.e. 1016 minutes and 32 seconds)
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New Technology
In comparison, the OpenCL accelerated implementation provided by Update 1 took only 6 minutes and 18
seconds to complete.
That represents a performance gain of over two orders of magnitude.

CONFIGURING OPENCL
In order to make use of OpenCL acceleration your computer must have both a hardware device capable of
processing using OpenCL, as well as an appropriate OpenCL driver installed for that hardware. The device
and driver must support at least OpenCL 1.2 with the double precision extension (cl_khr_fp64).
Since there may be more than one device capable of supporting OpenCL on your computer you should also
check the Configure OpenCL utility in ERDAS IMAGINE. To start this utility select File > Configuration >
Configure OpenCL. The Configure OpenCL utility will start.

In the example shown above, the computer has three possible devices capable of running OpenCL. The Up /
Down nudgers can be used to specify the priority order in which ERDAS IMAGINE attempts to use those
devices. In this case, the Quadro K5100M card will be utilized first.
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New Technology

Clicking on the Extensions tab will show what the selected device supports so that you can check to confirm
if cl_khr_fp64 is in the list:

May 31, 2018

7

New Technology

Also note the third device in the Compute Devices listing. Modern Intel CPUs are capable of running OpenCL
if an appropriate driver is installed. So even computers without a dedicated GPU device can attempt to gain
modest improvements in performance by installing OpenCL.

BACKGROUND PIXELS
The NNDiffuse Resolution Merge dialog has also been enhanced to provide for better handling of
background pixels that have not been set to NoData in the input imagery. In the case of Unsigned Integer
input data, locations where all bands are 0 will be treated as NoData and any locations that contain real pixel
values will never have a value less than 1 in the output file.
If different handling of background data is desired, you can always click the View button and modify the
underlying Spatial Model using the Spatial Model Editor to implement the exact approach desired.
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New Technology
EXAMPLE OF NNDIFFUSE PAN SHARPENING
The example below shows how the NNDiffuse sharpened image (shown on the right) retains the spectral
fidelity of the input, lower resolution multispectral image (shown on the left) while increasing the spatial
resolution four-fold (from 2m pixels to 0.5m pixels):

OTHER NEW OPERATORS FOR SPATIAL MODELER
Hexagon Geospatial has continued to add new operators to Spatial Modeler. New (or modified) operators
with a brief description of their capabilities are described. See ERDAS IMAGINE 2018 Help for full details of
each operator, as well as the Hexagon Geospatial Community > Spatial Recipes page, for examples of
Spatial Models that use many of these capabilities.

LINEAR REGRESSION

Computes slope and intercept parameters for a linear regression model predicting each band of a Dependent
raster dataset from an Explanatory dataset by a least squares fit.
A Slope matrix and an Intercept table are computed: if Dependent has M bands and Explanatory has N
bands, Slope will be MxN and Intercept will be Mx1.
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New Technology
A prediction of the Dependent raster can be computed as:
Predicted = LinearCombination(Explanatory, Slope) + Intercept.
This prediction minimizes the mean squared error of (Predicted - Dependent)
In the example below, the Linear Regression operator is used to color-match an older image to a newer one
for the purpose of filling in masked cloud holes in the newer image.

READ SENSOR METADATA
The Read Sensor Metadata operator has been enhanced to include Landsat 8, 7 and often 5, in the list of
sensors which can be automatically parsed.

RASTER STATISTICS PER FEATURE

Contrary to the original Help documentation, the Raster Statistics per Feature operator does work with
Area, Point and Line geometry types.
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New Technology

GENERAL ERDAS IMAGINE
DIGITALGLOBE TIL
The DigitalGlobe TIL raster format reader, which enables data that has been split into multiple physical image
files to be treated as a single image, has been improved in several significant ways:


An image consisting of JPEG 2000 encoded tiles will now be recognised as having pyramid
layers present



Overlapping tiles (as defined in the TIL header) are now supported by ERDAS IMAGINE



A problem whereby Level 1B data (as opposed to 2A or other levels) could cause the TIL
importer to exit abnormally has been addressed



Previously the TIL raster format reader would not retain the projection information associated
with Level 3 orthorectified data. This has been corrected.

ASTER L1T HDF
About a year ago, USGS/NASA LPDAAC introduced a new ASTER data product, L1T, which is
orthocorrected, in UTM projection, WGS84 datum. This is now the standard ASTER product but there was
previously no way to import these L1T data into ERDAS IMAGINE that preserved accurate UTM
georeferencing.
The HDF raster format reader can now directly ingest these ASTER images files, preserving projection
information while doing so.

FORMOSAT-5 DIMAP FORMAT
Data from the FormoSat-5 sensor in DIMAP v2 format can now be read directly in ERDAS IMAGINE.

SENTINEL-1 GRD XML FORMAT
An enhancement has been added to be able to read the Sentinel-1 GRD (Ground Range Detected) data in
XML format. Previously it was possible to read this data in a standard TIFF format (from the “measurement”
folder of the Sentinel-1 data package) and the TIFF raster DLL could be used to display it.
However, many customers find it more convenient to directly read all Sentinel-1 product types via the XML
header for consistency.

BINARY POINT FORMAT (BPF)
Several improvements have been made to the BPF reader, notably


When performing a Save As.. to LAS format, attributes are now transferred form the BPF file to
the LAS



When performing a Save As.. to LAS format, projection information is now preserved



BPF stores values as Floats while LAS stores as Integer. So when converting from BPF to LAS,
scaling needs to be applied to preserve precision. This was being done in the Import BPF to LAS
application, but not for the "Save As" functionality. This has now been implemented.
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New Technology
RPF IMPROVEMENTS
The RPF Exporter has been improved in a couple of areas:


Previously the RPF Maketoc process used the security classification of the last RPF frame for
setting the classification of the a.toc file. The software now scans all frames and uses the highest
classification.



RPF Maketoc has several NITF fields on the user interface but these were not being populated
from the NITF preferences. ERDAS IMAGINE is now using the "NITF Static" preferences to
populate the user interface so the operator does not have to retype the values every time they
create a product.

RSM IMPROVEMENTS
The user will now receive a warning message when attempting to add imagery with RSM models associated
with them to a Block file (using IMAGINE Photogrammetry) reminding the user to use the Mixed Sensor
Model option if they wish to perform adjustments on the models.
Also, in the Set Geometric Model dialog, if an RSM model is detected, the Existing Calibration radio button
will be automatically selected in order to streamline the most common workflow.

LANDSAT 5 FROM EARTHEXPLORER
The Landsat 4,5,7 or 8 from USGS importer now supports Landsat 5 imagery downloaded from the USGS
EarthExplorer site.

PKZIP DEFLATE VARIANT OF TIFF
Some imagery vendors, including the Hexagon Imagery Program (HxIP) use the PKZip variant of Deflate
when compressing TIFF imagery. This variant is now readable by ERDAS IMAGINE.

DON’T DISPLAY SPECIFIC NITF SEGMENTS
Certain NITF image segments will now be automatically excluded from display, or even showing up in the list
of possible segments to load, into the 2D View. These segments do not contain imagery - just TRE/DES.
They now only appear when using the NITF Info tab or View NITF Metadata. The segments are identified
by:


IID1 = PAN+TRE



IID1 = PAN+S



IID1 = PAN+FG

SIPS INTERPOLATION
When displaying imagery as an Image Chain, ERDAS IMAGINE uses a standardized SIPS XML file to
determine the appropriate default image display parameters. One of these parameters is Interpolation and
for most commercially available NITF images this is defined as LaGrange. Previously, when you displayed an
NITF image as an Image Chain, the interpolation definition was ignored and the image always defaulted to
Nearest Neighbor. With Update 1 the interpolation method is now defaulted correctly, as defined by the SIPS
XML.
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New Technology
MGRS AND GEOTRANS
The use of MGRS coordinates in ERDAS IMAGINE has been updated to use GeoTrans v3.7 in any
necessary coordinate transformations.
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System Requirements

SYSTEM REQUIREMENTS
ERDAS IMAGINE
Computer/ Processor

64-bit: Intel 64 (EM64T), AMD 64, or equivalent
(Multi-core processors are strongly recommended)

Memory (RAM)

16 GB or more strongly recommended

Disk Space



4 GB for software



7 GB for example data

Data storage requirements vary by mapping project1


Windows® 7 SP1 or higher, Professional and Ultimate (64-bit)



Windows® 8 (Standard), Professional and Enterprise (64-bit) 4



Windows® 8.1 (Standard), Professional and Enterprise (64-bit) 4



Windows 10 Pro (64-bit) 4



Windows Server 2012 R2 (64-bit)



Windows Server 2016 (64-bit)



OpenGL 2.1 or higher (this typically comes with supported graphics cards5)



Adobe® Reader® 7 or higher



Internet Explorer® 9 or higher with JavaScript enabled, or Firefox® 32 or higher
with JavaScript enabled



Java Runtime 1.7.0.80 or higher - IMAGINE Objective requires JRE and can
utilize any installed and configured JRE of version 1.7.0.80 or higher.



Python 3.4.x (Python is optionally usable with Spatial Modeler. In most cases 64bit Python is required; however, if you run 32-bit ERDAS IMAGINE / Spatial
Model Editor, or configure smprocess to not run 64-bit, 32-bit Python is also
required)



Microsoft DirectX® 9c or higher



.NET Framework 4.0



MSXML 6.0



OpenCL 1.2 with a device which supports double precision (cl_khr_fp64) if
wishing to GPU accelerate NNDiffuse and other Operators



NVIDIA® Quadro® K5200, K4200, K2200, K420 6

Operating Systems 2, 3

Software

Recommended
Graphics Cards
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System Requirements

Recommended Stereo
Display Monitors



NVIDIA Quadro K5000, K4000, K600 6



120 Hz (or above) LCD Monitors with NVIDIA 3D Vision™ Kit 7

All software installations require:


One Windows-compatible mouse with scroll wheel or equivalent input device



Printing requires Windows-supported hardcopy devices

8

Software security (Hexagon Geospatial Licensing 2018) requires one of the following:


Ethernet card, or



One USB port for hardware key

Advanced data collection requires one of the following hand controllers: 9

Peripherals

ArcGIS and GeoMedia
Interoperability

May 31, 2018



TopoMouse™ or TopoMouse USB™



Immersion 3D Mouse



MOUSE-TRAK



Stealth 3D (Immersion), S3D-E type, Serial Port



Stealth Z, S2-Z model, USB version



Stealth V, S3-V type (add as a serial device)



3Dconnexion SpaceExplorer mouse



EK2000 Hand Wheels



EMSEN Hand Wheels



Z/I Mouse



ERDAS IMAGINE can be safely installed on a computer that has GeoMedia
2014, GeoMedia 2015, GeoMedia 2016 or GeoMedia 2018 installed. However
for greatest compatibility, it is highly recommended to install matching versions
(including Updates).



ERDAS IMAGINE 2018 requires GeoMedia 2018 for live linking. Order of
installation does not matter.



ERDAS IMAGINE can interact with both types of personal Geodatabases (*.mdb
and *.gdb).



ERDAS IMAGINE can be safely installed on a computer that has ArcGIS®
versions 10.1 through 10.6.



ERDAS IMAGINE and IMAGINE Photogrammetry can interact with ArcGIS
Server 10 Geodatabase servers (ArcSDE). To read or interact with an Enterprise
Geodatabase, you must either:

10
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System Requirements


Install and license the appropriate version of ArcGIS for Desktop versions 10.1
through 10.6, OR



Install the IMAGINE Geodatabase Support (based on ArcEngine 10.5), which
requires no license



PostGIS 2.2: PostGIS can be used to store GeoMedia Features (.sfp)



Oracle Server 12c 12.1.0.2.4 64-bit: Oracle Server 12c can be used to store
Oracle GeoRaster (.ogr) (requires Oracle Spatial), SDE Raster (.sdi) (requires
ArcGIS for Server) and Oracle Spatial Features (.ogv) (requires Oracle Spatial),
as well as GeoMedia Features (.ofp).



Microsoft SQL Server 2014: Microsoft SQL Server 2014 can be used to store
GeoMedia Features (.sfp)

Database Engines

ERDAS IMAGINE SYSTEM REQUIREMENTS NOTES
1

Disk I/O is usually the slowest task in geospatial data processing. Faster hard disks improve productivity.
Reading data from one disk, writing temporary data to a second disk, and writing data to a third disk improves
performance. Disk arrays improve productivity, but some RAID options slow performance. Network disk
drives are subject to network limitations.
2 Server

Operating Systems are not supported for IMAGINE Photogrammetry, ORIMA or ERDAS ER Mapper.

3

The 3D stereo viewing and peripheral requirements of IMAGINE Photogrammetry limit its operating system
options.
4

ERDAS ER Mapper is not supported on Windows 8. It is considered Viable on Windows 8.1.

5

Windows provides a generic OpenGL driver for all supported graphics cards. However, an OpenGLoptimized graphics card and driver are recommended for these applications.
6

Graphics cards certified with previous versions of IMAGINE Photogrammetry and ORIMA may also be
compatible, but are not certified in the current version.
7

Stereo Monitors certified with previous versions of IMAGINE Photogrammetry and ORIMA may also be
compatible, but are not certified in the current version.
8

HP-RTL drivers are recommended. Windows 64-bit print servers require 64-bit print drivers.

9

Stealth S-Mouse (S2-S model) and MOUSE-TRAK are the only supported hand controllers in Stereo
Analyst® for ERDAS IMAGINE.
10

3Dconnexion SpaceExplorer mouse is supported in IMAGINE Photogrammetry.
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Issues Resolved

ISSUES RESOLVED
IMAGINE ESSENTIALS
Issue ID
IM-39607

Summary –
IMAGINE
Essentials

Description / How to Reproduce

Warptool throws
errors “cannot
create canvas
bitmap” when
collecting GCPs

When collecting several GCPs using a ECW VMC as a reference image, Warptool
begins to throw errors. Several hundred points may need to be taken over the image
area before the error occurs. Error warnings can be dismissed but reoccur with
increasing frequency to the point where the gcp collection process cannot be
continued.
Excerpt from the Session Log:
28/09/16 11:01:06 warptool(9924): Setting GCP #171 Destination X: 213258.163981
Y: 636391.700151 from Matching
28/09/16 11:01:06 warptool(9924): Setting GCP #171 Input X: 5.760417 Y: 1.148750
from Viewer
28/09/16 11:02:17 SessionMgr(9036): ERROR: #64 from
IGdiBitmapSurface::IGdiBitmapSurface
28/09/16 11:02:17 SessionMgr(9036): ERROR:
IGdiBitmapSurface::IGdiBitmapSurface failed
28/09/16 11:02:17 SessionMgr(9036): ERROR: #37 from
IGdiBitmapSurface::IGdiBitmapSurface
28/09/16 11:02:17 SessionMgr(9036): ERROR: CreateNewBitmapAndSelect failed
28/09/16 11:02:17 SessionMgr(9036): ERROR: #1 from CreateNewBitmapAndSelect
28/09/16 11:02:17 SessionMgr(9036): ERROR: Cannot create canvas bitmap

IM-36120

Windows locale
issues

May 31, 2018

There are locale related issues in feature preview and zonal change detection
workflow (among others).
532951 -- Modified to special handling of a single char decimal. (Fixes the feature
preview issue)
533042 -- Modified to use localeIndependentDoubleScan() and stream imbue locale
to fix the zonal change convert json string double values back error in european
locale (IM-35874)
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Issues Resolved
IM-44048

Still some cases
where statistics
are missing
rows/columns
with 3x3
pyramids

Pixels are missing when computing statistics while generating 3x3 pyramids. Using
ERDAS IMAGINE 2018 or older. To replicate:
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.
16.
17.
18.

IM-43326

IM-43020

Start ImageInfo and open radare.img
Edit | Compute Pyramid Layers/Statistics
Check Compute Pyramid Layers
Make sure the Algorithm is 3X3
Check Compute Statistics
Make sure the skip factors are both 1. Click OK
Open SM check_histogram_count.gmdx
Run it using radare.img as the input raster
Notice that the number of pixels in the histogram (69903360) is less than the
number of pixels in the image (69930666).
Clear the model
Open radare.img in ImageInfo again if needed
Edit | Compute Pyramid Layers/Statistics
Un_check Compute Pyramid Layers
Check Compute Statistics
Make sure the skip factors are both 1. Click OK
Open SM check_histogram_count.gmdx again
Run it using radare.img as the input raster again
Notice that the number of pixels in the histogram (bottom branch) now
_matches_the number of pixels in the image (top branch)

ERDAS
IMAGINE does
not show Google
Earth tab upon
installing Google
Earth Pro (64bit) installer

ERDAS IMAGINE 2018

Symbology file
(.evs file) for
Machine
Learning
shapefile report
files is not
working correctly

After reviewing some parcels (mark some to Correct, some Wrong, etc.), create
Shapefile report file. Open it in 2D Viewer and see that all parcels have the same
style.
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2.

Install Google Earth Pro (64-bit).
Launch ERDAS IMAGINE and observe that no Google Earth tab is displayed.
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Issues Resolved
IM-44436

Cannot save
custom color

After creating a custom color using Color Chooser’s Custom tab it is not possible to
save this new color. ERDAS IMAGINE 2018 crashes after entering the name for the
color and clicking OK in the Save Color dialog. If you run ERDAS IMAGINE 2018 as
an administrator, the new color only lasts for the current ERDAS IMAGINE session. If
you restart ERDAS IMAGINE the new custom color can no longer be found.
This problem does not occur using ERDAS IMAGINE 2016 v16.1.
1. Go to $IMAGINE_HOME\etc\ and make sure that “colors” folder and all of its
files are not read-only.
2. Start ERDAS IMAGINE 2018 without admin privileges.
3. Display the image “lnlandc.img” as pseudo color in a 2D View.
4. Click Table tab > View group > Show Attributes.
5. Click on any color in the Color column and choose “Other” from the list.
6. Select Custom tab in Color Chooser dialog and change the RGB values.
7. Click Save button to open the Save Color dialog. Enter a name for the new
custom color and save it in the Menu category, then click OK.
8. ERDAS IMAGINE crashes.
9. Open the menu.clb file found in $IMAGINE_HOME\etc\colors, and observe that
the new custom color was not added to the list
Try it again running ERDAS IMAGINE 2018 with administrator privileges.
1. Go to $IMAGINE_HOME\etc\ and make sure that “colors” folder and all of its
files are not read-only.
2. Start ERDAS IMAGINE 2018 with admin privileges.
3. Display the image “lnlandc.img” as pseudo color in a 2D View.
4. Click Table tab > View group > Show Attributes.
5. Click on any color in Color column and choose “Other” from the list.
6. Select Custom tab in Color Chooser dialog and change the RGB values.
7. Click Save button to open the Save Color dialog. Enter a name for the new
custom color and save it in the Menu category, then click OK.
8. New color is available in Menu category for the current ERDAS IMAGINE
session.
9. Open the menu.clb file found in C:\Program Files\Hexagon\ERDAS IMAGINE
2018\etc\colors. The new color has not been added.
10. Close ERDAS IMAGINE and start a new session. New custom color is not
available.

IM-44555

configure_all.ex
e re-configures
CSMs

If you run configure_all.exe (either the 32 or 64 bit versions), the original (default)
CSMs are added to the CSM configuration.
This did not occur pre 2018. This is undesirable because if user already has CSMs
configured, these new entries most likely reference a different folder location (can
only have one). If user has similar CSMs configured, their settings are overwritten.

IM-44376

HISTOA
DISP_FLAG not
set in correct
event for
PEDF/LinLog
remap

A change made for ERDAS IMAGINE 2018 has resulted in the HISTOA DISP_FLAG
in previously existing processing events (perhaps just the first one) being set to 1
when PEDF (and probably LinLog) correction is being applied.
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Issues Resolved
IM-44572

Displaying
multiple layers in
2D View is
slower in v16.5
than in v16.1

Open all 306 images from one of the datasets (not fit to window).
Notice that after the message at the bottom left of ewkspace says "Opening 306 of
306:" it takes a significant amount of time before the image is actually displayed. This
didn't happen in v16.1.
The problem is that we're trying to get the title for the view and we're querying all
layers from the bottom of the stack up for their titles. Need to do it from the top of the
stack down.

IM-44360

Some tiles are
missing while
displaying two
images in a 2D
Viewer, when at
least one image
has a Piecewise
geometry model

To reproduce the problem:
1. Open piecewisecalib.img in a 2D View.
2. Using Inquire Cursor (Legacy), go to [specific location].
3. Open affinecalib.img in the same viewer. Everything looks fine.
4. Hide the piecewisecalib layer, you'll see missing tiles on the left edges. Pls see
the attachment.
NOTE If the both images are opened as pseudo color images, they look fine in the
viewer. No tiles are missing.
Some warning and error messages from the Session Log:
16/04/18 12:28:07 SessionMgr(412): WARNING: #4531 from `anonymousnamespace'::ReadMaskPixels
16/04/18 12:28:07 SessionMgr(412): WARNING: The request for mask data @(-17,
10) of size (513, 513) appears to exceed the amount available from the previous read
of source pixels @(7167, 8181) of size (530, 513); resampling should eventually fail
16/04/18 12:28:07 SessionMgr(412): ERROR: #5410 from `anonymousnamespace'::ResampleBlockInterpolateInternal
16/04/18 12:28:07 SessionMgr(412): ERROR: No memory for source data read and
further subdivision of destination is impossible

IM-12074

ERDAS
IMAGINE does
not import /
Direct read
certain MODIS
HDF files

When trying to read directly MODIS HDF data, ERDAS IMAGINE throws the error:
“MODIS_Grid_16DAY_250m_500m_VI_0_GRID~250m 16 days red reflectance:
Name too long”
Even after accepting all the error message, the HDF file does not display in the 2D
View.
Discovered that ERDAS IMAGINE 2013 v13.0.2 as well as with ERDAS IMAGINE
2014 can’t import the HDF file. Error message presented when trying to import the
HDF file:
22/10/13 23:12:05 C:/Intergraph/ERDAS IMAGINE
2013/bin/Win32Release/imgcopy.exe -w Importing HDF Data -t IMAGINE Image -g
FALSE -p FALSE -s 1
d:/{user}/modis/mod13q1.a2009065.h20v08.005.2009083104347.hdf
d:/{user}/imported_mod13q1a2009065h
20v080052009083104347.img
22/10/13 23:12:05 SessionMgr(7568): Unloading [dllimport.eml]...
22/10/13 23:13:29 SessionMgr(7568): ERROR: #345 from imgcopy
22/10/13 23:13:29 SessionMgr(7568): ERROR: eimg_FileCopy failed
22/10/13 23:13:29 SessionMgr(7568): ERROR: #8159 from eimg_FileCopy
22/10/13 23:13:29 SessionMgr(7568): ERROR: eimg_LayerStackCopyVA failed
22/10/13 23:13:29 SessionMgr(7568): ERROR: #12085 from
eimg_LayerStackCopyVA
22/10/13 23:13:29 SessionMgr(7568): ERROR: eimg_LayerCopy failed
22/10/13 23:13:29 SessionMgr(7568): ERROR: #9238 from eimg_LayerCopyVA
22/10/13 23:13:29 SessionMgr(7568): ERROR: eimg_LayerCreate failed
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22/10/13 23:13:29 SessionMgr(7568): ERROR: #6105 from eimg_LayerCreateVAPtr
22/10/13 23:13:29 SessionMgr(7568): ERROR: eimg_LayerCreateInternal fail
22/10/13 23:13:29 SessionMgr(7568): ERROR: #6630 from
eimg_LayerCreateInternal
22/10/13 23:13:29 SessionMgr(7568): ERROR: FileLayerNameSet failed
22/10/13 23:13:30 SessionMgr(7568): imgcopy.exe exited with status -1.
22/10/13 23:17:17 eWkspace(7212): Unloading [import_data.eml]
IM-14988

Export TIFF
Subset does not
place Calibrated
image in correct
location

Customer reported that with TIFF / BigTIFF/ BigGeoTiff / GeoTIFF and JFIF exporter,
if subset area is defined in Export Option dialog (either by bounding box or by the
inquire box), the image extent in exported image will have the extent of the entire
image (not the extent of the defined subset area), in that way the subsetted image is
shifted to an unrealistic location. This issue occurs both in ERDAS IMAGINE 2014
and 2013.
Recreated the problem with customer data. Found that whatever method is chosen
for subsetting the image in the TIFF exporter (either by defining ULX-Y, LRX-Y, or by
using the InquireBox), the exported image shows the ULX-Y of the original image.
1. Display the image in the viewer (exported to TIFF)
2. Click Manage Data tab > Export Data.
3. Select "TIFF" for Format. Select the Input image .
4. Set Output File to some directory and click OK for Export dialog.
5. In Export TIFF Data dialog, click "Export Options".
6. Click Home tab > Inquire > Inquire Box to open Inquire box in the 2D View.
Define subarea within the input image.
7. In Export Options dialog, click "From Inquire Box" and draw / or define your
own ULX-Y, LRX-Y. Click OK to close Export Options dialog.
8. In Export TIFF Data, click Batch button to display command for this process.
9. Check "-upperleft 323212 4307788 -lowerright 323369 4307506" parameters to
see if the defined coordinate are reflected in the command in Batch Command
Editor.
10. Click Run Now in Batch Command Editor.
11. Display exported file in the 2D View and also open Image Metadata for this
data.
Notice the exported image is placed at the top left corner of original image and the
coordinate information is incorrectly assigned.

IM-14968

Export TIFF
Subset does not
place ortho
image in correct
location

Customer reported that with TIFF / BigTIFF/ BigGeoTiff / GeoTIFF and JFIF exporter,
if subset area is defined in Export Option dialog (either by bounding box or by the
inquire box), the image extent in exported image will have the extent of the entire
image (not the extent of the defined subset area), in that way the subsetted image is
shifted to an unrealistic location. This issue occurs both in ERDAS IMAGINE 2014
and 2013.
Recreated the problem with a customer data. Found that whatever method is chosen
for subsetting the image in the TIFF exporter (either by defining ULX-Y, LRX-Y, or by
using the InquireBox), the exported image shows the ULX-Y of the original image.
1. Display the customer’s image in the viewer (exported to TIFF)
2. Click Manage Data tab > Export Data.
3. Select "TIFF" for Format. Select the Input image .
4. Set Output File to some directory and click OK for Export dialog.
5. In Export TIFF Data dialog, click "Export Options".
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6.

Click Home tab > Inquire > Inquire Box to open Inquire box in the 2D View.
Define subarea within the input image.
7. In Export Options dialog, click "From Inquire Box" and draw / or define your
own ULX-Y, LRX-Y. Click OK to close Export Options dialog.
8. In Export TIFF Data, click Batch button to display command for this process.
9. Check "-upperleft 323212 4307788 -lowerright 323369 4307506" parameters to
see if the defined coordinate are reflected in the command in Batch Command
Editor.
10. Click Run Now in Batch Command Editor.
11. Display exported file in the 2D View and also open Image Metadata for this
data.
Notice the exported image is placed at the top left corner of original image and the
coordinate information is incorrectly assigned.
IM-38435

TIL direct-read
importer crashes
with DG Level
1B data (if not
R1C1)

Go to Import
Select type as DigitalGlobe TIL
Specify the input image as Cadiz,
Spain_40cm_1BStereo_4band_GeoTIFF\053894986010_01_P001_MUL\14AU
G28110738-M1BS_R2C1-053894986010_01_P001.til
4. Click OK
5. Click OK in the tertiary dialog.
The import progress meter gets to 29% and then crashes.

IM-44408

CADRG Batch
Export does not
export multiple
input images

CADRG Batch Export only writes the first image in the input list
1. Manage Data > Export Data > CADRG
2. Input File: 1_250k_8_1_5_1_250k_8_5.img
3. Select Output File & Folder
4. Select ‘Merge’ from Product Build Mode menu
5. Select Scale = 1:250 JOG Radar (larger scale used to increase speed of
processing)
6. Select Batch
7. From Batch Command Editor set Variables as ‘One or more inputs, one output’
8. Select ‘Add Files’ and pick the second image 1_250k_8_1_6_1_250k_8_5.img
9. Select ‘Run Now’
10. Display RPF Product
11. File Open Raster Layer
12. Select RPF Product generated above, Raster Options – Fit to Frame
13. OK Answer yes to compute Pyramid layers if not already computed
Process runs without errors but only exports the first file in the input list. Session log
shows the product is partially generated using only the first image. Manually exporting
both files generates the full RPF product using both input IMG files.
The solution is to use the File > Batch Export Images into One RPF option.l A note
should be made in the Help file to this effect.

IM-43932

Exporting
uncompressed
TIFF to
JPEG2000 fails
with error
“:Layer_1|Node

When exporting an uncompressed TIFF file to JPEG 2000 format it fails with the error
message “:Layer_1|Node already exists for file <filename>.aux”. This problem does
not occur in ERDAS IMAGINE 2016 v16.1. This may be related to IM-43586.
1. Open the Export tool – click Manage Data tab > Export Data
2. In the Export tool set the format to JPEG 2000
3. Select the file “73048_0_0027.tif” as the input file.
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already exists
for file”

4.
5.
6.

Enter a name for the output file and click OK.
Use the default settings in the Export to JPEG 2000 dialog and click OK.
Progress meter opens and it begins to process, but then an error message
opens saying: “:Layer_1|Node already exists for file
e:/output/73048_0_0027_2018export.aux”

IM-43439

Bad jp2 creation
when converting
between tif and
jp2 using
EncoderFactory:
:CreateEncoder

ERDAS APOLLO has a custom utility that is used to convert between image types. It
is producing invalid jp2 files.
Same conversion in ERDAS IMAGINE 2018 seems to work without issue.
"C:\Program Files\Hexagon\ERDAS
APOLLO\lib\bin\x64urelease\ImagineRasterProcessor" -meta -s
c:\apollodata\9_SID_Images_0.tif -o c:\apollodata\temp\9_SID_Images_0.jp2 imagine_home "c:\Program Files\Hexagon\ERDAS APOLLO\lib" -arch x64 arch_mode urelease

IM-43422

Landsat importer
cannot import
specific Landsat
7 .tar.gz

LE07_L1TP_019036_20180117_20180212_01_T1.tar.gz
Problem could be that it has a gap_mask subdirectory in the tar file and etar doesn't
know what to do with that.

IM-43366

Error when
exporting a
specific ECW file

May 31, 2018

1.
2.
3.
4.
5.
6.

Launch ERDAS IMAGINE 2018
Launch Export from Manage Data > Conversion > Export
Select the format as ECW
Load the image RemapData_yellowstone.ecw
Provide the output location and click Ok and Ok on Export ECW Data
Observe that an Error thrown -GDAL Error (not recognized as a supported file
format) which is not the case with ERDAS IMAGINE 2016 v16.1
NOTE: This error observed only with this file and in this case output was created
successfully.
Session log:
10/02/18 16:27:33 SessionMgr(10996): Connection success for the external process
'eWkspace'
10/02/18 16:30:35 eml export_data.eml;
10/02/18 16:33:06 C:/Program Files/Hexagon/ERDAS IMAGINE
2018/bin/Win32Release/exportecw.exe -inputfilename d:/000009-022018/test/remapdata_yellowstone.ecw -outputfilename
c:/users/agangumo/appdata/local/temp/.imagine1650/remapdata_yellowstone.ecw gui
10/02/18 16:33:07 exportecw: 0
10/02/18 16:33:07 exportecw: 0
10/02/18 16:33:07 exportecw: 0
10/02/18 16:33:07 exportecw: 0
10/02/18 16:33:07 exportecw: 0
10/02/18 16:33:07 exportecw: 0
10/02/18 16:33:08 exportecw: 0
10/02/18 16:33:08 exportecw: 0
10/02/18 16:33:08 exportecw: 0
10/02/18 16:33:08 exportecw: 0
10/02/18 16:33:08 exportecw: 0
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10/02/18 16:33:08 exportecw: 0
10/02/18 16:33:08 exportecw: 0
10/02/18 16:33:08 exportecw: 0
10/02/18 16:33:08 exportecw: 0
10/02/18 16:34:04 C:/Program Files/Hexagon/ERDAS IMAGINE
2018/bin/x64URelease/exportecw.exe -inputfilename d:/000009-022018/test/remapdata_yellowstone.ecw -outputfilename
c:/users/agangumo/appdata/local/temp/.imagine1650/remapdata_yellowstone.ecw band
s 1 2 3 -photointerp RGB -compratio 20 -ecwversion 3 -resample Nearest Neighbor noDataColor Black -inputecwmode 1 -nthreads 8 -encodeCache 75
10/02/18 16:34:04 SessionMgr(10996): exportecw.exe exited normally.
10/02/18 16:34:05 exportecw: 0
10/02/18 16:34:05 exportecw: 0
10/02/18 16:34:05 exportecw: 0
10/02/18 16:34:05 exportecw: 0
10/02/18 16:34:05 exportecw: 0
10/02/18 16:34:05 exportecw: 0
10/02/18 16:34:05 exportecw: 0
10/02/18 16:34:05 exportecw: 0
10/02/18 16:34:05 exportecw: 0
10/02/18 16:34:06 exportecw: ERROR 4: `d:/000009-022018/test/remapdata_yellowstone.ecw' not recognized as a supported file format.
10/02/18 16:34:06 exportecw:
10/02/18 16:34:06 SessionMgr(10996): Available Physical Memory = 10570.45 MB
10/02/18 16:34:06 SessionMgr(10996): Available Virtual Memory = 131071.73 GB
10/02/18 16:34:06 SessionMgr(10996): [exportecw] Cache max memory to encoding
= 7927.84 MB.
10/02/18 16:34:06 exportecw: 0
10/02/18 16:34:06 exportecw: 0
10/02/18 16:34:06 exportecw: 00
10/02/18 16:34:06 exportecw:
10/02/18 16:34:06 exportecw: 00
10/02/18 16:34:06 exportecw: 00
10/02/18 16:34:06 exportecw: 0
10/02/18 16:34:06 exportecw: 00
10/02/18 16:34:06 exportecw: 0
10/02/18 16:34:06 exportecw:
10/02/18 16:34:06 exportecw: 0
10/02/18 16:34:06 exportecw:
10/02/18 16:34:06 exportecw: 000
10/02/18 16:34:06 exportecw: 0
10/02/18 16:34:06 exportecw: 0
10/02/18 16:34:06 exportecw: 0
10/02/18 16:34:06 exportecw:
10/02/18 16:34:06 exportecw:
10/02/18 16:34:06 exportecw: 00
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10/02/18 16:34:06 exportecw:
10/02/18 16:34:06 exportecw: 00
10/02/18 16:34:06 exportecw:
10/02/18 16:34:06 exportecw: 0
10/02/18 16:34:06 exportecw:
10/02/18 16:34:08 exportecw: 0
10/02/18 16:34:08 exportecw: 0
10/02/18 16:34:08 exportecw: 0
10/02/18 16:34:08 exportecw: 0
10/02/18 16:34:08 exportecw: 0
10/02/18 16:34:08 exportecw: 0
10/02/18 16:34:10 SessionMgr(10996): exportecw.exe exited normally.
10/02/18 16:38:15 SessionMgr(10996): ERROR: #221 from GDALTryOpenDataset
10/02/18 16:38:15 SessionMgr(10996): ERROR: GDAL Error: `d:/000009-022018/test/remapdata_yellowstone.ecw' not recognized as a supported file format.
10/02/18 16:38:15
IM-42512

Importing
Landsat 5 data
throws error 'We
don't have rights
to modify file!'

ERDAS IMAGINE 2018
Manage Data Tab > Import data > Format : Import Landsat 4, 5, 7, or 8 from USGS
Input data:
Landsat5_USGS\LT05_L1TP_043027_20111114_20160830_01_T1.tar.gz
Try to import the data, observe that ERDAS IMAGINE throws below error:
ERROR: We don't have rights to modify file!
Seesion log info:
04/12/17 13:04:37 C:/Program Files/Hexagon/ERDAS IMAGINE
2018/bin/Win32Release/importusgsl7.exe -inputfilename
landsat5_usgs/lt05_l1tp_043027_20111114_20160830_01_t1.tar.gz -outpu
tfilename d:/del/im64.img -gui
04/12/17 13:05:14 SessionMgr(6128): ERROR: #270 from importusgsl7::main
04/12/17 13:05:14 SessionMgr(6128): ERROR: Importer::UntarAll failed
04/12/17 13:05:14 SessionMgr(6128): ERROR: #232 from Importer::UntarAll
04/12/17 13:05:14 SessionMgr(6128): ERROR: etar_EntryExtract failed
04/12/17 13:05:14 SessionMgr(6128): ERROR: #976 from etar_EntryExtract
04/12/17 13:05:14 SessionMgr(6128): ERROR: Error changing access time
04/12/17 13:05:14 SessionMgr(6128): ERROR: #2816 from efio_SetModTime
04/12/17 13:05:14 SessionMgr(6128): ERROR: We don't have rights to modify file!
04/12/17 13:05:14 SessionMgr(6128): importusgsl7.exe exited normally.

IM-42322

Non-Ascii
characters not
supported in
lggi::biif::DataSe
t::IsSupported
and
lggi::biif::DataSe
t::Open

Running something like
DataSet::IsSupported(L"C:\desktop\слово.ntf");
will cause IsSupported to crash, and Open to attempt to open the incorrect file.
It looks like the issue is in FileInputSource::FileInputSource in
lggibiif\FileInputSource.cpp where the filename is converted to ascii.
Input incorrectly shows the fileName as "?????.ntf" instead of "слово.ntf".

IM-44377

PEDF remap is
being applied

Somewhere prior to the release of ERDAS IMAGINE 2018, a bug was introduced that
results in the PEDF remap trying to stretch to a full 16 bits instead of the 11 specified
by the remap table.
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incorrectly for
certain data

Found two data sets that show this problem - both are uncompressed data. Found at
least two, perhaps more, data sets that do not have this problem - they are J2K
compressed.

IM-44007

Incorrect stats
reported for
DIMAP v2
Pleiades image

When DIMAP XML header of Pleiades image is opened in ImageInfo, stats indicate a
Skip of 1 x 1, which gives the impression that full stats have been calculated, but they
have not. The Median is 0, which does not seem right for data with a range of 204 to
4094.
Calculate stats with a skip of 1 x 1 and Direct Binning to see more believable stats.
The other odd thing is that on the Pixel Data tab it thinks that there's a Mask present
defining NoData (using value 0).
But when the JP2 image is opened directly in ImageInfo, it reports that there is no
NoData.
Something does not seem right with the way the DIMAP v2 raster is reading data.

IM-38496

Resample dialog
produces Float
output that has
NoData
problems

Reported by customer who is trying to process Sentinel-1 imagery
1. Display test_2_subset_reproj.img in a 2D View.
2. Click ImageInfo and observe that the image has NoData set as NaN (for Float).
3. Select Raster tab / Resolution group / Spatial / Resample Pixel Size
4. Fill in the output filename
5. Set pixel size to 30 x 30m, turn on Square Cells
6. Click OK to run the process (which is running an old PMDL model).
7. Open the resulting image (e.g. test_2_subset_resamp.img) in the 2D View.
8. Click ImageInfo button.
Error message (many times):
"Condition set to ALLDATA, but found NODATA pixel value"
Perform the resampling using new Spatial Modeler (e.g. resample.gmdx) - there are
no such problems.

IM-44564

OLH - SQL
Server Features
Proxy (*ofp)
should be
modified to SQL
Server Features
Proxy (*sfp)

IM-41923

Save As
functionality for
Point Cloud
formats uses
first alphabetical
plugin format
when saving to
LAS

May 31, 2018

1.
2.
3.

Launch ERDAS IMAGINE 2018 Help
Navigate to Feature Connection Manager dialog using URL
Observe that Files of Type was mentioned as SQL Server Features Proxy
(*ofp). Should be modified to SQL Server Features Proxy (*sfp)

When adding a new Point Cloud format for BPF data, when it was active, the "Save
As" on a LAS file no longer worked. It complained about the version number (from the
LAS metadata).
When the pf_bpf.dll file was deleted, the "Save As" functionality returned to
normal. This was when loading a LAS file and doing a "Save As" on the top layer.
It should not have been accessing the BPF plug-in at all in that case. Temporary fix disabling write capability in the pf_bpf DLL. But this is just a temporary fix as we will
need to be able to use the "Save As" function in BPF. And it should save as BPF, not
LAS in that case. This should probably be another bug entry but PointCloudAccessLib
forces the "Save As" to be LAS format. Then of course the save fails under BPF
because the metadata is not meant for LAS in that case.
But this bug here is more immediate because in this case it appears the wrong PF
DLL is being accessed - it seems to be using the first one available with write access
as opposed to looking for LAS itself. In the base Imagine code, the first one with write
capability just happens to be pf_las so it works out.
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IM-43013

Most optimized
resample
methods have
NoData
problems

It appears that the optimized resample methods have problems that make it possible
for these resample methods to inappropriately give rise to NODATA in the interior of a
resampled output.
The following set of optimized resample methods may be impacted:
sources_gio/rm_gop/gop.cpp
sources_gio/rm_rationalfunc/rationalfunc.cpp
sources_rdo/rm_camera/camera.cpp
sources_rdo/rm_framecamera/framecamera.cpp
sources_rdo/rm_landsat/landsat.cpp
sources_rdo/rm_pushbroom/pushbroom.cpp
sources_rdo/rm_rubbers/rubbers.cpp
sources_rdo/rm_spot/spot.cpp

IM-44369

Connection to a
geodatabase
fails with ArcGIS
10.6 installed

1. Install ERDAS IMAGINE 2018
2. Install ArcGIS 10.6
3. Launch ERDAS IMAGINE
4. Right click in viewer and select Open Vector layer.
5. In file chooser select ArcGIS Geodatabase (*.gdb) and click Connect.
Notice that an error opens and the subsequent dialog used for selecting/connecting to
a gdb file does not open.
NOTE: Tried the following combinations and the connection to geodatabase was
successful.
* ERDAS IMAGINE 2016 + ArcGIS 10.5.1
* ArcGIS 10.6 + ERDAS IMAGINE 2016

IM-39708

Column in
shapefile’s
attribute table
with German
umlauts
disappears
when Enable
Editing option
turned on

1. Open Flaeche_34.shp in 2D View
2. Display attribute table by clicking Table > Show Attributes.
3. Activate Enable Editing option from Drawing tab.
4. Attribute column will disappear.
It can be resolved by editing the .dbf file within some reader, like Notepad++, and
search/replace the umlauts (ä, ö, ü, ß). Also simple model with Features Input and
Features Output operators can fix it. In new shapefile created by such model all
umlauts will be replaced by other symbols and the column will not disappear.

IM-24340

Duplicate of IM18956:
Digitalglobe/Eart
hWatch til file
with affine
transformation

No referencing information is read from \\auwlv\Data\TIL\ManyTiles\054081433010_01_P001_MUL\14OCT07175542-M3DS054081433010_01_P001.TIL
This is because file has no RPC. It has affine matrix instead.

IM-18956

DigitalGlobe TIL
raster dll is not
retaining
projection
information

See DG WorldView-2 imagery
If you open any individual GeoTIFF tile you will see that they have georeferencing
information because this is Level 3 orthorectified data.
However if you use the TIL dll to read all tiles at once, or use the TIL importer to
convert to an IMG, the projection information is lost.
TIL dll needs to handle L3 data.

IM-21179

Copy/Paste of
pixels into Map
View does not
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Launch ERDAS IMAGINE.
Add View > Create New Map View.
Open a picture in Windows Paint.
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work under
Windows 8.1

4. Try copy/paste it into the Map View.
No picture is pasted into Map View.

IMAGINE ADVANTAGE
Issue ID
IM-44069

Summary –
IMAGINE
Advantage
Mosaic Color
balancing crashes
for Per image
processing

Description / How to Reproduce

1.
2.
3.
4.
5.
6.

Raster Tab > Launch MosaicPro > Add these images: *wasia1.img, wasia2.img
and wasia3.img*
Select all the images in table > select this icon *Make selected images visible*
Click *Display raster images* > Launch *Display color correction* dialog
under *Display Color Balancing dialog* select *Use Color balancing* > Set >
Select *Manual Color manipulation*
Select *Per Image* and click *Compute Current* in the next dialog
It crashes when clicking *Compute Current*

IM-43867

MosaicPro
crashes when
adding images to
a project

MosaicPro immediately crashes when loading specific images to a project.
Some of the images in this project have the same extent.

IM-40411

MosaicPro may
crash while
mosaicking as well
as reprojecting
from
WGS84/NUTM33
to ETRS89 /
NUTM32

Customer is mosaiking and reprojecting 5 images dataset using MosaicPro tool as
well as mosaicprocesspro.exe via the command line. Customer found that changing
the target projection seems to have an influence on the crash. Input data are in
projection WGS84/NUTM33 EPSG 32633. Re-projection to 32632 or 25832
(neighboring UTM zone) causes the crash. Re-projecting to other projections
(32634,4326,3857,..) works fine.
Customer support after investigation found that if the two NE corner image (of the
data sent by the customer) is excluded in the mosaicprocess, rest of the three images
are reprojecting into EPSG 25832 without any problem. If the two NE corner images
are separately used during mosaic and reprojection into EPSG 25832 CRS, then also
there is no problem with MosaicPro.
According to the customer, those data are derived from Sentinel-2 datasets. The
processing taking place is a simple layer stack (in this case the 60m bands only) and
masking to set NODATA in cloud areas, executed in the SpatialModeler. The final
data are written using the 'Raster Output' Operator
For reproducing the crash in commandline, do the following. Data contain the actual 5
image files, the input file list used for the cmd and the text file with executed cmds.
1. Adjust paths in fileList.txt accordingly
2. Start mosaicprocesspro.exe on the command line, adjust the paths
accordingly:
"C:\IDK\ED_2016\root\bin\x64URelease\mosaicprocesspro.exe" -imagelist
"E:\Testing\sentinel\test_mosaic\fileList.txt" -overlapfunction overlay -d -proj 'EPSG
Coordinate Systems' 'ETRS89 / UTM zone 32N (25832)' -o
"E:/Testing/sentinel/test_mosaic/mosaic_60m.ecw"
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IMAGINE OBJECTIVE
Summary –
IMAGINE
Objective

Description / How to Reproduce

IM-36757

Outlier Clipper
operator using
Convex clip fails

Using VCO Outlier Clipper operator with Clip type set to Convex fails with error
“fe_process.exe exited with status -1073741819”. Outlier Clipper operator with Clip
type set to Concave runs successfully.
To recreate:
1. Open Objective project outlier_clipper.lfp
2. Run
Error dialogue opens: Feature Extraction Process has stopped working
Session log error: 15/11/16 14:19:44 SessionMgr(3844): fe_process.exe exited with
status -1073741819.
Compare:
1. VCO Cleanup Operators > Outlier Clipper Properties tab > Clip type > Concave
2. Run
Model runs without error

IM-43633

Error message
when starting
IMAGINE
Objective

When you first start IMAGINE Objective 2018 (16.5) an error message occurs that
Bayesian could not be used, because JRE is missing.

IM-42839

IMAGINE
Objective Outlier
Clipper set to
"convex" causes
errors

Customer reported the following error when using the Vector Cleanup Operator
'Outlier Clipper', and Objective crashes.
"Unable to read f:/testshape1.shpXML character encoding not supported"
Error occurs only when the 'Clip' parameter of Outlier Clipper Operator is set to
'Convex'. When set to 'Concave' the process finishes successfully. Other operators
such as Generalize, Orthogonality, and Convex Hull all finish successfully using the
same input
1. Create a new project. Create a new feature model.
2. Add 2 variables, 1 Raster, 1 Vector (shp).
3. Set Vector Cleanup Operators to Start / Stop.
4. Click the I/O tab and change the Input from Vector Layer to .shp vector layer.
5. Add the Outlier Clipper and choose Convex.
6. Run
You should get the following error message:
"Unable to read f:/testshape1.shpXML character encoding not supported" and then
Objective crashes.

Issue ID

IMAGINE PHOTOGRAMMETRY
Issue ID

Summary –
IMAGINE
Photogrammetry
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Description / How to Reproduce
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IM-43060

Running APM with
ADS images as
input crashes
ERDAS IMAGINE

Open the blockfile and run APM. Notice that ERDAS IMAGINE crashes. This
happens with both 32-bit and 64-bit interfaces of ERDAS IMAGINE. The following is
the log in the event viewer when APM is run from 64-bit interface.
_Faulting application name: eWkspace.exe, version: 16.5.0.99, time stamp:
0x5a5e700c_
_Faulting module name: IXForm.dll, version: 16.5.0.99, time stamp: 0x5a5e6333_
_Exception code: 0xc0000005_
_Fault offset: 0x000000000000d2a4_
_Faulting process id: 0x4074_
_Faulting application start time: 0x01d38f77fe60a5bc_
_Faulting application path: C:\Program Files\Hexagon\ERDAS IMAGINE
2018\bin\x64URelease\eWkspace.exe_
_Faulting module path: C:\Program Files\Hexagon\ERDAS IMAGINE
2018\usr\lib\x64URelease\GeometricModels\IXForm.dll_
_Report Id: fab32bcb-4db2-45ca-b2fd-a16bee8efce9_
_Faulting package full name:_
_Faulting package-relative application ID:_

IM-44352

Rectangle Profile
Tool in Point
Cloud Layer
crashes for BPF

Rectangle Profile Tool in the Point Cloud Layer crashes for BPF because the code
tries to create temp LAS files for the profile windows but it assumes the metadata
from the source is for LAS and not potentially some other format like BPF.
It crashes when an exception is thrown because the version number is not correct for
LAS. Propose to use a fix similar to that for IM-41923, which allowed for "Save As" in
point cloud to save BPF as LAS.

IM-43132

OLH: BPF as
Point Cloud format
info is not present
in OLH

OLH: BPF as Point Cloud format info is not present in OLH

IM-43106

Help
corresponding to
Photogrammetric
tab should be
updated

1.
2.
3.
4.

IM-39194

INPHO version 6
or 7 project fails to
import to IMAGINE
Photogrammetry

May 31, 2018

Launch ERDAS IMAGINE 2018
Load any block file (Ex: laguna.blk)
Click Photogrammetry tab and click F1 to launch help page -Photogrammetry
Workspace
Observe that Terrain portion should be updated with Tridicon Semi- Global
Matching and Xpro Semi- Global Matching instead of Semi- Global Matching
because Hyper link on Semi- Global Matching is pointing to Xpro Semi- Global
Matching only.

There are some additional differences in camera format in INPHO version 7.1.0. It
fails to import in IMAGINE Photogrammetry.
Customer had to take $DATE row out and then take part of $CALIBRATION_SET out
from its subcategory to make it work. It is related to Camera definition. Basically they
have generated a new category called $CALIBRATION_SET and hide camera
calibration data there. CCD_INTERIOR_ORIENTATION, FOCAL_LENGTH etc. have
been switched to this category. Change has happened after INPHO version 5. INPHO
is now on version 7 but it was on new style already in version 6.
Version 5 camera definition that works:
$CAMERA
$TYPE : UCE97
$DATE : 09:33:27 07/10/2013
$BRAND : Custom
$KIND : CCDFrame
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$CCD_INTERIOR_ORIENTATION :
192.3076923077 0.0000000000 6539.5000000000
0.0000000000 -192.3076923077 10004.5000000000
$CCD_COLUMNS : 13080
$CCD_ROWS : 20010
$PIXEL_REFERENCE : TopLeftTopLeft
$FOCAL_LENGTH : 79.800000
$PRINCIPAL_POINT_PPA : 0.000000 0.000000
$PRINCIPAL_POINT_PPS : 0.000000 0.000000
$GPS_ANTENNA_OFFSET : 0.000000 0.000000 0.000000
$CAMERA_MOUNT_ROTATION : 0.000000
$END
Version 6-7 INPHO camera definition that crashes:
$CAMERA_DEFINITION
$ID : UCE97
$BRAND : Custom
$KIND : CCDFrame
$CCD_COLUMNS : 13080
$CCD_ROWS : 20010
$PIXEL_REFERENCE : TopLeftTopLeft
$CAMERA_MOUNT_ROTATION : 0.000000
$ACTIVE_CALIBRATION : 1
$CALIBRATION_SET :
$ID : 1
$MODE : manual
$DATE : 09:33:27 07/10/2013
$CCD_INTERIOR_ORIENTATION :
192.3076923077 0.0000000000 6539.5000000000
0.0000000000 -192.3076923077 10004.5000000000
$FOCAL_LENGTH : 79.800000
$PRINCIPAL_POINT_PPA : 0.000000 0.000000
$GPS_ANTENNA_OFFSET : 0.000000 0.000000 0.000000
$END
$END
IM-43597

RPC generation
crashes

Using block file from ..\sources_highdrag\LPS_Data\LPS\spot, the RPC generation in
x64 crashes when creating rpc_*.uai files. 32 bit works fine.

IM-43431

ERDAS IMAGINE
crashes if
Tridicon/XPro
SGM is launched
with nonsupported sensors

Open a frame camera/satellite/ADS blockfile in ERDAS IMAGINE 2018 64-bit viewer.
Try to launch XPro SGM. Notice that ERDAS IMAGINE 2018 crashes.
If we do the same workflow with 32-bit then a message (attached screenshot) would
show up.
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IM-43782

Failure at the end
of the process due
to Tridicon
intermediate files
limitation

In order to produce a DSM with 6 granules of satellite images, customer uses the
Semi-Global Matching (SGM) tool. The first step of SGM is to calculate Tridicon
Intermediate files for each couple of images. If a Tridicon intermediate file generated
is bigger than 4GB, ERDAS IMAGINE returns an error and stop the process.
To overcome this limitation, they already extract just the green band of each image
and work with these, however there is still one couple which is bigger than 4GB.
If possible please compute output intermediate image size in advance, for example
displaying a warning to prevent knowing the issue at the end of the process.

IM-44375

ERDAS IMAGINE
hangs when
creating DTM
pyramids in a
block file

Software hangs at line 1751 in ..\sources_gio\tf_raster\RasterTerrainDataset.cpp
when calling emet_MeterInfoCreate.
1. Map \\sanads01\Share2 to Q
2. Open a block file from \\alpha\JIRA_data\IM-44375
3. In Contents area, highlight Terrain, select Table tab under Photogrammetry
group and click Show Attributes to bring up the Terrain cell array.
4. Pyramid cell is red.
5. Click the cell to open Compute DTM Pyramid Layer dialog. Click OK and
IMAGINE hangs.
Software does not hang if not calling emet_MeterInfoCreate.

IM-43923

Remove Noise
fails to launch

After configuring the LASTools, from the *Preprocess* group of *LASTools* tab click
on *Remove Noise*.
A warning opens and the dialog fails to launch.

IM-43922

Launching any
LASTools
command shows
error in session
log

After configuring the LASTools extension, try to launch any command from the
LASTools ribbon tab. Notice that the following error message opens.
_LAStoolsRibbon: log4cplus:ERROR PropertyConfigurator::configureLogger()- Invalid
appender: DefaultAppender_

IM-43865

Remove Duplicate
fails to launch and
crashes

After configuring the LASTools, from the LASTools ribbon under Preprocess group
click on the Remove Duplicate option.
Notice that there is a crash dialog

IMAGINE PROFESSIONAL
Issue ID
IM-43459

Summary –
IMAGINE
Professional
Help - AutoGrid
Help is absent

May 31, 2018

Description / How to Reproduce

1.
2.
3.
4.
5.
6.

Change Layout to the Machine Learning Layout.
Go to the ML Process tab and create a new project.
Add an image to analyse.
On the Project Properties group left-click Zones and select Autogrid
On the Autogrid dialog click the Help button.
Goes to the Help Errors page.
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IM-43458

Help - ML Process
tab Help is a copy
of Zonal Change
Detection help

IM-43536

Deep Learning
layout result is
messed up unless
feature request
budget is set to
zero

When running classification in the machine learning layout, we have found that the
results are messed up unless we set the feature request budget to zero (in
Preferences)

IM-43489

Zonal Change
attention dialog
from Machine
Learning layout

When closing a Machine learning project, we get prompted to save the project.
Message says "Save zonal change project before closing?" This needs to change.

IM-43229

Classify using
Machine learning
does not generate
string outputs if
compute
probability is set to
false

Classify using Machine learning does not generate string outputs if compute
probability is set to false.
If you set compute probability is set to True, string output classes are created.
When it is set to false, only numeric output classes are created.
This is reproduced for SVM and Random Forest

IM-43021

A better progress
bar handling for
Machine Learning
process run is
needed.

In Machine Learning Layout, click Run Current Run.
Go to Process List dialog and watch that the progress bar for smprocess
reaches to 100% quite quickly.
3. But when I select Load Results, nothing happens.
It turns out that I have to wait quite some time until smprocess really finishes. Then
Load Results works fine.

IM-42537

Zonal change >
Image difference
fails in Batch
Region mode - fix
the typo

ERDAS IMAGINE 2018:
1. Create a new project :
Before - TheVillagesSubset2008 - Copy.img
After - TheVillagesSubset2007 - Copy.img
Parcel - TheVillagesParcelsSubset.shp
2. Set Algorithm as Image Difference in Region properties.
3. Run in 'Batch Region(s)' mode.
4. Observe that execution fails with below errors in session log:
06/12/17 18:04:29 SessionMgr(11752): HexGeo::SpatialModeler::Operator::Execute
failed
06/12/17 18:04:29 HexGeo::SpatialModeler::Operator::Execute failed
06/12/17 18:04:29 HexGeo::SpatialModeler::Operator::Execute failed
06/12/17 18:04:29 HexGeo::SpatialModeler::Operator::Execute failed
06/12/17 18:04:29 HexGeo::SpatialModeler::Operator::SetErrorMessage failed
06/12/17 18:04:29 Spatial Model failed in Data Input 2. The error was "Input file does
not exist: d:/del/ads/Region0_Output/alg_parameters.json".
06/12/17 18:04:29 SessionMgr(11752): Spatial model failed.

May 31, 2018

1.
2.
3.

Change Layout to the Machine Learning Layout
Go to the ML Process tab and click the Help icon (far right corner)
Note that other than the first sentence, the Help seems to be the Help for the
Zonal Change Detection process tab.

1.
2.
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IMAGINE SAR INTERFEROMETRY
Issue ID

Summary –
IMAGINE SAR
Interferometry

Description / How to Reproduce

IM-43306

Help is not in
place for the
command
Displacement
order from radar
tools

IM-43713

Error removing
temp file
occasionally

Occasionally the temp files created during coregister are not deleted. The error is
reported in the session log.

IM-43367

Coherence
Texture not
created in EZ
Sentinel CCD

Coherence texture file is not created when asked for

IM-43365

AutoEnhance from
Radar Utilities
failing with
improper message
in Session Log

May 31, 2018

1.
2.
3.
4.
5.

Launch IMAGINE 2018
Load a radar image Insar_match.img from example data
Activate Radar Analyst from Raster tab and select Tools from Radar tab
Launch the command Displacement Order
Click Help of the command and observe nothing happens.

1.
2.
3.
4.
5.

Launch ERDAS IMAGINE 2018
Launch AutoEnhance from Raster > Radar Toolbox > Utilities
Load any SAR image
Provide the output file name and click Ok
Observe that Process fails and session log saying “There was No input file
available”, which is not the case with ERDAS IMAGINE 2016 v16.1
Note: Tried with different radar images, in all cases issue was reproducible.
Session log:
10/02/18 15:35:28 SessionMgr(8248): Connection success for the external process
'eWkspace_64'
10/02/18 15:38:32 eWkspace_64(9624): Loading [radar_auto.eml]...
10/02/18 15:43:39 C:/Program Files/Hexagon/ERDAS IMAGINE
2018/bin/x64URelease/smprocess.exe $IMAGINE_HOME/etc/models/radarcolorize.gmdx Raster Input.Filename=d:/23-06-2017/sar/bluenewdemodata/dims_op_oc_dfd2_204280199_1/tsx-1.sar.l1b/tsx1_sar__ssc____
__hs_s_sra_20090924t232619_20090924t232620/tsx1_sar__ssc______hs_s_sra_2
0090924t232619_20090924t232620.xml MagnitudeLayer.Value=1.000
Exponent.Value=2.300 AutoEnhancedImage.FilenameIn=d:/000009-022018/autoenhnace_848.img Sobel1.KernelName=7x7 Sobel 1 S
obel2.KernelName=7x7 Sobel 2 FilterWindow.KernelName=5x5 Low Pass
AutoEnhancedImage.PixelType=F32 AutoEnhancedImage.NoDataValue=0
Scale.Test=False
10/02/18 15:43:39 eWkspace_64(9624): Unloading [radar_autoenhance.eml]...
10/02/18 15:43:40 SessionMgr(8248): Running spatial model
($IMAGINE_HOME/etc/models/radar-colorize.gmdx) with port values (Raster
Input.Filename=d:/23-06-2017/sar/bluenewdemodata/dims_op_oc_dfd2_204280199_1/tsx1.sar.l1b/tsx1_sar__ssc______hs_s_sra_200
90924t232619_20090924t232620/tsx1_sar__ssc______hs_s_sra_20090924t232619
_20090924t232620.xml,MagnitudeLayer.Value=1.000,Exponent.Value=2.300,AutoEn
hancedImage.FilenameIn=d:/000009-022018/autoenhnace_848.img,Sobel1.KernelName=7x7 Sobel 1,Sobel2.KernelNa
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me=7x7 Sobel 2,FilterWindow.KernelName=5x5 Low
Pass,AutoEnhancedImage.PixelType=F32,AutoEnhancedImage.NoDataValue=0,Sca
le.Test=False).
10/02/18 15:43:40
10/02/18 15:43:40 smprocess:
10/02/18 15:43:41 smprocess:
10/02/18 15:43:41 smprocess:
10/02/18 15:43:41 smprocess:
10/02/18 15:43:41 smprocess:
10/02/18 15:43:41 SessionMgr(8248): HexGeo::SpatialModeler::Operator::Execute
failed
10/02/18 15:43:41 HexGeo::SpatialModeler::Operator::Execute failed
10/02/18 15:43:41 HexGeo::SpatialModeler::Operator::Execute failed
10/02/18 15:43:41 HexGeo::SpatialModeler::Operator::Execute failed
10/02/18 15:43:41 HexGeo::SpatialModeler::Operator::Execute failed
10/02/18 15:43:41 HexGeo::SpatialModeler::Operator::Execute failed
10/02/18 15:43:41 HexGeo::SpatialModeler::Operator::SetErrorMessage failed
10/02/18 15:43:41 Spatial Model failed in Raster Input. The error was "No input file
available".
10/02/18 15:43:41 SessionMgr(8248): Spatial model failed.
10/02/18 15:43:41
10/02/18 15:43:41 SessionMgr(8248): smprocess.exe exited with status 1.
IM-44571

Harmonize
Displacement
service titles

Harmonize Displacement service titles - make all the titles the same.

IM-44409

Time-series CCD AGE files are not
created for
Magnitude

Time-series CCD. AGE files are not created for Magnitude. The coherence file of the
same type works fine.

IM-44434

AGE and M3 do
not create for
Magnitude

AGE and M3 do not create for Magnitude, but coherence works OK. Time series CCD

SPATIAL MODELER
Issue ID
IM-43791

Summary –
Spatial Modeler

Description / How to Reproduce

Documentation for
Spatial Model
‘Feature Input’
Operator is
incorrect regarding
Database
Connections

‘Features Input’ operator documentation has link to a Database Connections topic
where the different types of available database connections are listed. However, the
Database Connections topic list of database types does not match the available types
in the current version of Features Input operator.
Specifically the Database Connections topic lists these databases:
Oracle Database Server
ArcGIS Geodatabases (File and Personal)
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ArcSDE Database Server
SQL Database Server
However the current available Database Connections for the ‘Features Input’ operator
are actually:
Oracle
SQL Server
PostGIS
IM-43470

Help is broken for
‘Select Attributes’
dialog

IM-43223

Help: Mismatch
between the
Default number of
ports in Machine
Learning
Operators in SM
Editor and OLH
pages

IM-44553

Help - Define
Functional
Attribute operator
help page –
update to show all
ports figure

In Spatial Model Editor, drag and drop _’Select Attributes’_ operator.
Double-click on _’AttributeNames’_ input port and launch _’Select Attributes’_
dialog
3. Click Help button on this dialog
Help is broken and help errors page is displayed.
1.
2.

1.
2.

Launch ERDAS IMAGINE > Toolbox Tab > Spatial Model Editor
Drag and drop these Machine Learning operators and launch Online Help page
and compare the Default ports:
*Initialize Deep Intellect*
*Classify Using Deep Learning*
*Initialize Inception*
*Classify Using K-Means
Observe that there is a mismatch between the Default ports shown in Spatial Model
Editor and OLH pages
1.
2.
3.

Launch Spatial Model Editor
Drag Define Functional Attribute operator to Spatial Model Editor and launch
Help
Observe that figure corresponding to Show all ports was missing.

IM-43564

Features Input
operator: error if
specify GeoMedia
Warehouse Proxy
(.gwp) as input for
Features Input

Help topic on Features Input Operator documents the use of GeoMedia Warehouse
Proxy (.gwp) file(s) as input for the Features Input Operator. Attempting to use .gwp
for simple Access warehouse as input however, results in errors such as:
erdas::sb_CGP::VectorSource_X::OnExecute failed Unsupported file type
Features Input operator seems to only support the following data sources:
Oracle
arcview shapefile
* SQL Server
* (specific geometry type not known)

IM-43936

Help for Raster
Statistics per
Feature is wrong

Raster Statistics per Feature Operator topic
[https://hexagongeospatial.fluidtopics.net/reader/5VsIDRDWkTIfq4xcVz8V4w/HwnYy
EfjzhgAg3dMq44qBw]
In Description section it states “ If not needed, CalcMeanport has to be set to False”.
There is no CalcMeanport port.
In Limitation section it states “The operator only works for AreaGeometry field types.
An error is generated otherwise.”. But I can use point features and no error is
generated. I don’t get the correct results – but I don’t get an error either.
Connections table is just wrong. All the stats ports are named incorrectly.

May 31, 2018

36

Issues Resolved
IM-44003

Features
Database Output
operator forcing
Oracle installer

‘Features Database Output’ operator refuses to work, throwing an error “64-bit Oracle
client is required but not installed” when you click Add in Output Connection.
1. In Spatial Model Editor window add and connect Features Input and Features
Database Output operators.
2. Within Features Input operator connect to PostGIS Database
3. Double click Features Database Output. Click Add. The “64-bit Oracle client is
required but not installed” error opens.

IM-43122

Features Output
operator may fail if
input feature data
is large

Current MAINTAIN_ORDER option implementation in Features Output operator may
not work if the input feature data is too large to fit in the available memory.

IM-44552

Per Feature
operators creating
mostly 0’s in
output

Computing Variance Texture per Feature results in all 0s in the output attribute except
for the features that touch the top of the image footprint. Also behaves the same way
for Statistics Per Feature operator.

IM-43969

Initialize inception
operator default
ports should be
corrected

Initialize using deep intellect operator has all its ports shown by default. But according
to the approved operator design the optional ports should be hidden by default.
So, make the following ports hidden ports to make them in sync with the design.
* LearningRate
* ValidationPercentage

IM-43968

Initialize deep
intellect operator
default ports
should be
corrected

Initialize using deep intellect operator has all its ports shown by default. But according
to the approved operator design the optional ports should be hidden by default.
So, make the following ports hidden ports to make them in sync with the design.
* LayerCount
* ProcessingWidth
* ProcessingHeight
* LearningRate
* TrainingSteps
* BatchSize
* ValidationPercentage

IM-43967

Classify using
deep learning
operator default
ports should be
corrected

Classify using deep intellect operator has all its ports shown by default. But according
to the approved operator design the optional ports should be hidden by default.
So, make the following ports hidden ports to make them in sync with the design.
* ClassAttributeBasename
* ProbabilityAttributeBasename
* AttributeNamePrefix

IM-43954

Default value for
DistributionType in
Initialize Naive
Bayes is not
correct

Current default value for the DistributionType port for the Initialize Naive Bayes
operator is Multinomial which is out of sync with the approved design and the online
documentation.
Change the default to Gaussian.

IM-43946

Classify using KMeans operator
default ports
should be
corrected

Classify using K-means operator has all its ports shown by default. But according to
the approved operator design the optional ports should be hidden by default.
So, make the following ports hidden ports to make them in sync with the design.
* RandomSeed
* ClassificationAttributes
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* ClassAttributeName
IM-42289

Deep Learning
Train fails on a 13
layer convolution
net if max. pooling
layer has a stride
definition of 1 X 1

May 31, 2018

1.
2.

A CNN model is created with 13 layer network (model attached)
The model has 5 max pooling layers and stride is defined as 1 X 1 for each
pool
3. The model is then trained on a dataset (UCMerced_LandUse) which has 2100
images distributed across 21 feature classes.
*Observation:*
The training of the model fails probably because of resource exhaustion.
*NOTE*: The same exact model can be trained successfully (on the same system) if
the striding is defined as 3 X 3 for all the 5 max pooling layers.
+Session Log records the following:+
21/11/17 15:07:42 SessionMgr(14148): Executing spatial model:
d:/test/models/dl_conv2d_13l.gmdx
21/11/17 15:07:42 SessionMgr(14148): Running command line: C:/Program
Files/Hexagon/ERDAS IMAGINE 2018/bin/x64URelease/mlpywrapper.exe
"C:/Users/lpkota/AppData/Local/Temp/SPATIAL_MODELER-b8d4-a840-fa9d-9830003300/modelgene2166627-a6f9-4124-a9d6-f527096
a0e92.py" "C:/Users/lpkota/AppData/Local/Temp/SPATIAL_MODELER-b8d4-a840fa9d-9830-003300/mlpy_jsoninput_94d50205-4685-4d86-8b6c-2f20e8415fc1.Json"
"C:/Users/lpkota/AppData/Local/Temp/SPATIAL_MODELER-b8d4-a840-fa9d-9830003300/mlpy_jsonoutput_8b112790-ae
1b-446f-9952-2000f8b9b9dc.Json"
21/11/17 15:08:08 SessionMgr(14148): OOM when allocating tensor with
shape[27320832,4096]
21/11/17 15:08:08 SessionMgr(14148): [[Node:
FC1/kernel/Initializer/random_uniform/RandomUniform =
RandomUniform[T=DT_INT32, _class=["loc:@FC1/kernel"], dtype=DT_FLOAT,
seed=0, seed2=0, _device="/job:localhost/replica:0/task:0/cpu:0"](FC1/kernel/Initial
izer/random_uniform/shape)]]
21/11/17 15:08:08 SessionMgr(14148):
21/11/17 15:08:08 SessionMgr(14148): Caused by op
'FC1/kernel/Initializer/random_uniform/RandomUniform', defined at:
21/11/17 15:08:08 SessionMgr(14148): File "mlpywrapper_x64.py", line 71, in
<module>
21/11/17 15:08:08 SessionMgr(14148): File "mlpywrapper_x64.py", line 65, in main
21/11/17 15:08:08 SessionMgr(14148): File "mlpywrapper_x64.py", line 52, in
mlpywrapper
21/11/17 15:08:08 SessionMgr(14148): File
"C:/Users/lpkota/AppData/Local/Temp/SPATIAL_MODELER-b8d4-a840-fa9d-9830003300/modelgene2166627-a6f9-4124-a9d6-f527096a0e92.py", line 243, in
smmlpyfunction
21/11/17 15:08:08 SessionMgr(14148): classifier.fit(x=train_x(training_data),
y=train_y(training_data),batch_size=10, steps=10)
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\util\deprecation.py", line 281, in new_func
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\contrib\learn\python\learn\estimators\estimator.py", line 414, in
fit
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21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\contrib\learn\python\learn\estimators\estimator.py", line 1317, in
fit
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\util\deprecation.py", line 281, in new_func
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\contrib\learn\python\learn\estimators\estimator.py", line 430, in
fit
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\contrib\learn\python\learn\estimators\estimator.py", line 927, in
_train_model
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\contrib\learn\python\learn\estimators\estimator.py", line 1132, in
_get_train_ops
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\contrib\learn\python\learn\estimators\estimator.py", line 1103, in
_call_model_fn
21/11/17 15:08:08 SessionMgr(14148): File
"C:/Users/lpkota/AppData/Local/Temp/SPATIAL_MODELER-b8d4-a840-fa9d-9830003300/modelgene2166627-a6f9-4124-a9d6-f527096a0e92.py", line 135, in
create_model_fn
21/11/17 15:08:08 SessionMgr(14148): Input27_result =
tf.layers.dense(Input26_result, 4096,name='FC1')
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\layers\core.py", line 218, in dense
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\layers\base.py", line 320, in apply
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\layers\base.py", line 286, in __call__
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\layers\core.py", line 123, in build
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\ops\variable_scope.py", line 1049, in get_variable
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\ops\variable_scope.py", line 948, in get_variable
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\ops\variable_scope.py", line 349, in get_variable
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\layers\base.py", line 275, in variable_getter
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\layers\base.py", line 228, in _add_variable
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\ops\variable_scope.py", line 341, in _true_getter
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\ops\variable_scope.py", line 714, in _get_single_variable
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\ops\variables.py", line 197, in __init__
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\ops\variables.py", line 275, in _init_from_args
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\ops\variable_scope.py", line 690, in <lambda>
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21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\ops\init_ops.py", line 369, in __call__
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\ops\random_ops.py", line 236, in random_uniform
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\ops\gen_random_ops.py", line 263, in _random_uniform
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\framework\op_def_library.py", line 768, in apply_op
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\framework\ops.py", line 2336, in create_op
21/11/17 15:08:08 SessionMgr(14148): File "sitepackages\tensorflow\python\framework\ops.py", line 1228, in __init__
21/11/17 15:08:08 SessionMgr(14148):
21/11/17 15:08:08 SessionMgr(14148): *{color:#d04437}ResourceExhaustedError
(see above for traceback): OOM when allocating tensor with
shape[27320832,4096]{color}*
21/11/17 15:08:09 SessionMgr(14148): [[Node:
FC1/kernel/Initializer/random_uniform/RandomUniform =
RandomUniform[T=DT_INT32, _class=["loc:@FC1/kernel"], dtype=DT_FLOAT,
seed=0, seed2=0, _device="/job:localhost/replica:0/task:0/cpu:0"](FC1/kernel/Initial
izer/random_uniform/shape)]]
21/11/17 15:08:09 SessionMgr(14148):
21/11/17 15:08:10 SessionMgr(14148): Could not understand JSON for type:
IMAGINE.File
21/11/17 15:08:10 SessionMgr(14148): Spatial model execution failed.

IM-43949

Raster Statistics
per Feature swaps
Primary Geometry
from Point to Area

The model converts single pixel classes to area geometries via Convert to Features.
It then creates centroids, which adds a Point geometry field as the primary geometry,
but Area is retained as a secondary geometry.
When I then feed the Features to Raster Statistics per Feature, either the process is
switching the primary geometry type back to Area, or it's entirely ignoring the point
geometry, because the resulting (primary) geometries are Area again. They should
remain Points.

IM-43945

Add "deep
learning" as
keyword for these
operators

When you search for deep learning, you will not find these operators since "deep" is
not one of the keywords.
* Machine Intellect Input
* Machine Intellect Output
* Initialize Inception

IM-43938

Why doesn't
Raster Statistics
per Feature give
correct values?

Raster Statistics Per Feature, when using Point geometries, does not always return
the expected values

IM-43916

Convert to Surface
operator fails to
write raster

ERDAS IMAGINE someties crashes while using the "Convert to Surface” operator

IM-43899

Normalize Height
operator fails with
error: Bad numeric
Conversion:positiv
e overflow

Customer reported that Normalize Height operator fails with error: Bad numeric
Conversion:positive overflow
Customer is trying to make a model where point cloud is inputted as a LAS and goal
is to get out point cloud where DEM effect is removed (points above the ground).
They can create DEM using Surface operator but when they feed something to
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Normalize Height operator nothing comes out and it ends up in errors. That has
happened with two separate lidar datasets.
IM-43745

Changing the
RadianceMap type
in Analyze
Radiance operator
crashes software.

Open the provided model in Spatial Model Editor.
It's a simple model trying to generate output in radiance units for a given DEM
file.
3. Saved model has 'RadianceMap Type' defined as 'Radiation' and
'GroundReflectance' value as '1.000000'
4. Run the model and preview is displayed successfully.
5. Fit the displayed Preview to full frame.
6. Change the 'GroundReflectance' to 0.5
7. Model runs and preview is updated successfully.
8. Next change the 'RadianceMap Type' to 'Shaded Radiation'
ERDAS IMAGINE software crashes immediately.

IM-43328

After Preview,
model fails to Run
– Feature Analysis
pack issue

1. Open the provided model in Spatial Model Editor
2. Click Preview
Model will successfully Preview.
3. Click Run.
Model fails to run with message stating
"Object reference not set to an instance of an object."
4. Turn Preview off and Clear the results on all Operators.
5. Click Run.
Successful.

IM-44447

SQL Server Proxy
File ConnectInfo's
Data Source
parameter value is
empty for windows
authentication
mode

The SQL Server Proxy File ConnectInfo's Data Source parameter value is empty for
windows authentication mode.

IM-44690

Filter By
Geometries
operator failed
with message
Iterator not
dereferencable

Customer reported that they used to filter vector objects within the Spatial Modeler in
ERDAS IMAGINE 2016 v16.1 with no issue. But when they tried the same model with
ERDAS IMAGINE 2018, it failed at operator Filter By Geometries with the message
"Iterator not dereferencable".

IM-43754

ERDAS IMAGINE
crashes while
running model
containing
Normalize Height
operator

Customer reported that ERDAS IMAGINE crashes while running customer's model
with Normalize Height operator.
Customer is using a terrain model (DTM), a (classified) point cloud that contains high
tension lines and a line feature to define the high tension line. When the customer
runs the model, almost immediately after the model hits the Normalize Height
operator, ERDAS IMAGINE stops working.

IM-43404

Image Metadata is
unable to show
Datum and
projection info
written in SPOT6 /
7 JPEG2000
images

Customer reported that Image Metadata dialog is unable to show Datum and
projection info written in the SPOT6 / 7 JPEG 2000 images, when the JPEG 2000
image has WGS84 / Geographic projection system. Image Metadata dialog shows the
projection system as RAW in those JP2 files.
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IM-33505

Temp File cannot
be deleted when
running model
second time

Open the model
Click Run
Specify an output PDF filename and Run.
Wait for model to successfully finish.
Click Run again.
Say yes, you wish to delete the existing output file.
Click Run in the autogenerated dialog.
While executing the Create Geospatial PDF operator a dialog is thrown
showing the message in the screenshot.
9. Click Cancel and it seems to complete successfully.
That message continues to come up every time you subsequently try to run the model
(unless you select all Operators and Clear Results first)
Session Log:
19/05/16 12:38:38 SessionMgr(8968): Executing spatial model: //alpha/jira_data/im33505/send_to_geospatial_pdf_v16-0-0.gmdx19/05/16 12:38:45 SessionMgr(8968):
Spatial model execution complete.19/05/16 12:38:54 eWkspace(10820): File
//alpha/jira_data/im-33505/charleston.pdf is deleted.19/05/16 12:38:57
SessionMgr(8968): Executing spatial model: //alpha/jira_data/im33505/send_to_geospatial_pdf_v16-0-0.gmdx19/05/16 12:41:49 SessionMgr(8968):
ERROR: #1118 from imgFileDestroy19/05/16 12:41:49 SessionMgr(8968): ERROR:
efio_FileUnlink failed19/05/16 12:41:49 SessionMgr(8968): ERROR: #4429 from
efio_FileUnlink19/05/16 12:41:49 SessionMgr(8968): ERROR: Unable to delete the
file h:\temp\SPATIAL_MODELER-e0ba-0197-3bce-6465-010820\a1bc813e-20f54e13-a257-6b079fec5410.rrd19/05/16 12:41:49 A write was attempted on a pipe or
FIFO for which there was no process to read the data.19/05/16 12:41:49
SessionMgr(8968): ERROR: #6952 from eimg::FileDestroy19/05/16 12:41:49
SessionMgr(8968): ERROR: eimg::FileDestroy failed19/05/16 12:41:49
SessionMgr(8968): ERROR: #6974 from eimg::FileDestroy19/05/16 12:41:49
SessionMgr(8968): ERROR: eimg::FileDestroy failed19/05/16 12:41:49
SessionMgr(8968): ERROR: #6972 from eimg::FileDestroy19/05/16 12:41:49
SessionMgr(8968): ERROR: AFileDestroy failed19/05/16 12:41:49
SessionMgr(8968): ERROR: #3762 from AFileDestroy19/05/16 12:41:49
SessionMgr(8968): ERROR: FileDestroy function failed19/05/16 12:41:53
SessionMgr(8968): Spatial model execution complete.

IM-43864

Normalize Heights
operator fails to
process data in
EPSG:3006

Customer reported:
LAS file with EPSG: 3006 fails with "invalid datum" error messages in Spatial
Modeler.

IM-43601

Python crashes
loading
ComputeHeightFr
omRelief.gmdx

Run pybug.py in Python 3.4. Python crashes - if running in IDLE, you'll see:
{code:java}
Loading model...
>>> ================================ RESTART
================================{code}
(whereas you should see "...done!" and some info about the model.)

IM-43586

Raster Input ->
Raster Output
model fails with
JP2 in and out
when
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1.
2.
3.
4.

Create a Spatial Model with a Raster Input connected to a Raster Output.
Set the ReadMetadata port on the Raster Input to true.
Select the JP2 file in the data directory as the input raster.
Specify a JP2 file for the output raster.
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ReadMetadata is
true

5. Run the model.
6. Raster Output fails with the error messages below.
* If you turn off the ReadMetadata port, the model runs successfully.
22/02/18 17:29:16 SessionMgr(1716): ERROR: #3435 from imgFileLayerNamesSet
22/02/18 17:29:16 SessionMgr(1716): ERROR: hfaLayerMove failed
22/02/18 17:29:16 SessionMgr(1716): ERROR: #7487 from hfaLayerMove
22/02/18 17:29:16 SessionMgr(1716): ERROR: ehfa_EntryMove failed
22/02/18 17:29:16 SessionMgr(1716): ERROR: #5923 from ehfa_EntryMove
22/02/18 17:29:16 SessionMgr(1716): ERROR: :Layer_1|Node already exists for file
c:/data/ri2r0.aux
22/02/18 17:29:17 SessionMgr(1716):
erdas::raster::CreatableGridCoverageFormatEIMG::TransferBandNaming failed
22/02/18 17:29:17 eimg_LayerChangeName failed
22/02/18 17:29:17 Name change of c:/data/ri2r0.jp2(:Band_1) to :Layer_1 failed

IM-43582

Rapid
Atmospheric
operator not
working in ERDAS
IMAGINE 2018

ERDAS IMAGINE 2018
1. Load the Spatial Model found in \\alpha\JIRA_data\IM-43582
2. Click Preview
3. Fails with a "Failed processing meta-data file. Sensor is not supported."
message
Same model runs fine in ERDAS IMAGINE 2016 v16.1

IM-43427

CGA
SpreadRasterAda
pter might
generate wrong
results for all but
the first tile

This problem affects the following operators: Cost Spread, Least Cost Path, Path
Back Network, and Proximity Spread. All those operators use CGA
SpreadRasterAdapter internally. In ERDAS IMAGINE, the TileSize
of Intergraph::GridAnalysis::RasterAdaptors::RasterAdaptor is set to 512 . So if the
output file size is wider or taller than 512, the pixels not in the first tile might not be
correct and all have value zero.

IM-43358

Spatial Modeler
does not create
consistent
Histograms or
other Statistics

ERDAS IMAGINE 2018
See model copied to \\alpha\JIRA_data\IM-43358
Open the model in a Spatial Model Editor and click Run.
My initial reason for creating this model was to show that the Histogram created by
Spatial Modeler is sometimes wrong. See the Sum value on the "GIS Statistics"
operator. It does NOT represent the number of pixels in the image, despite being 1x1
statistics (in theory). 2433 x 1433 = 3486489
However I also then noticed that other stats vary, even though the data should be
identical on all 4 branches.

IM-43329

View & Preview
buttons on RGB
Shaded Relief
dialog don't work
correctly

Steps to demonstrate the problems.
1. Raster tab | Resolution group | Spectral popup | RGB Shaded Relief.
2. Select a multi-layer image (lanier.img will work) and a single-band image
(lndem.img will work).
3. Click View. Model is displayed in Spatial Model Editor.
4. Click in the Spatial Model Editor canvas. Notice that the RGB Filename and
Intensity Filename ports don't have the filenames set. Click on the RGB Input
and Intensity Input operators and see that the values are set on those Filename
ports.
5. Click the Run and/or Preview buttons on the Spatial Modeler tab. You are
prompted for input filenames and there are no default values.
6. Click the Preview button on the dialog. You get an error: "Spatial Model failed
in Intensity Input. The error was "No input file available"." You get no Preview.
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IM-43319

Buffer Zones
Properties dialog
has an option that
does nothing

Drag the Buffer Zones operator into a Spatial Model Editor.
Double-click the operator to open the Buffer Zones Properties dialog.
Note the option to Merge Touching Buffers, but this checkbox does not do anything.

IM-43321

Merge Features
operator crashes
ERDAS IMAGINE
– Feature Analysis
pack issue

Open the model inbuffer2.gmdx in Spatial Model Editor
Click Preview
Once the data previews (incorrectly - see linked bug), double-click the Spatial
Operator / Contained By port and change to Touch.
As soon as you click OK, ERDAS IMAGINE will crash.

IM-43320

Merge Features
operator results in
wrong results Feature Analysis
pack issue

See the two models (and data) copied to \\alpha\JIRA_data\IM-43320
I would expect both models to produce identical results, but inbuffer1.gmdx seems
correct, while inbuffer2.gmdx incorrectly returns all the tax parcels.

IM-43157

Help of Features
related operators
have incomplete
info

Help of Features related operators have incomplete info.
To list a few:
* Intersect Features:
Related operators, Metadata path and Example model is empty.
* Set Primary Geometry:
This has Description and Connections section only.
* Define Functional Attribute:
Example model is empty.

IM-43156

Intersect Features
operator errors out
in specific
sequence of
operators run Feature Analysis
pack issue

ERDAS IMAGINE 2018
Intersect Features operator errors out in specific sequence of execution
In the attached model (intersectfeatures_preview.gmdx), (where Intersect Features
operator is connected to Preview operator), preview works fine.
Now connect Insert Features output operator in between Intersect features operator
and preview. Hit run or preview. SM errors out stating as "Object reference not set to
an instance of an object.", for both Intersect Features and Features Output operators',
and preview in 2D view is blank.

IM-43150

Least Cost Path
operator
generates
erroneous 0-value
columns

If AutoStudyArea is set to TRUE, the result is correct. Otherwise, the erroneous 0value columns show up.

IM-43140

Classify Using
Deep Learning
operator updated
with newly
modified figure

IM-43119

Drag and drop
operation for a
LAS file onto
Spatial Modeler is
not creating an
input operator
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3.

Launch Spatial Model Editor.
Drag the Classify Using Deep Learning operator to the Spatial Model Editor.
Launch the help and observe that operator shown in help and operator on
Spatial Model Editor are shown differently.

1. Open Spatial Model Editor
2. Drag and drop any .las file to Spatial Model Editor canvas.
3. No Point Cloud Input operator is created.
Expected behavior - should create a Point Cloud Input operator with the las file as
input name.
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IM-43105

ERDAS IMAGINE
crashes with
model containing
Image pair and
Image Pair
Information
operator.

IM-43102

Default and Show
all ports showing
same operator
Eliminate
Unwanted Areas

1.
2.
3.

IM-44600

Previewing
GeoCSV file
throwing different
errors in ERDAS
IMAGINE 32 bit
and 64 bit

1.

May 31, 2018

1. Load the attached model in the Spatial Model Editor
2. Provide the inputs as
Left file:
\KOMPSAT3\Stereo\K3_20130205130436_03856_00841311_L1R_Bundle\K3_2013
0205130436_03856_00841311_L1R\K3_20130205130436_03856_00841311_L1R_
N.tif
Right file:
\KOMPSAT3\Stereo\K3_20130205130557_03856_00841311_L1R_Bundle\K3_2013
0205130557_03856_00841311_L1R\K3_20130205130557_03856_00841311_L1R_
N.tif
3. Click on preview to execute the model and observe ERDAS IMAGINE crashes.
Note: It is also reproducible with 64-bit by executing the model 2-3 times.
Event log:
Faulting application name: eWkspace.exe, version: 16.5.0.108, time stamp:
0x5a6425e5
Faulting module name: tbbmalloc.dll, version: 2017.0.2016.1004, time stamp:
0x57f4099a
Exception code: 0xc0000005
Fault offset: 0x00015e91
Faulting process id: 0x2d2c
Faulting application start time: 0x01d3943bfc671070
Faulting application path: C:\Program Files\Hexagon\ERDAS IMAGINE
2018\bin\Win32Release\eWkspace.exe
Faulting module path: C:\Program Files\Hexagon\ERDAS IMAGINE
2018\bin\Win32Release\tbb\tbbmalloc.dll
Report Id: 755fc645-002f-11e8-838f-b8ca3a86789b
Faulting package full name:
Faulting package-relative application ID:
Launch Spatial Model Editor
Drag the operator Eliminate Unwanted Areas and check show all ports
Observe that with and without show all ports the operator is same but online
help is different for default and show all ports.

Launch Spatial Model Editor and preview the GeoCSV File attached
(states.csv) using Features input and Preview.
2. Observe that Model execution shown as success but session log showing
errors differently in 32 bit and 64 bit.
Expectation:
Model should fail and Error message should be proper ( 64 bit session log)
+Session log 32-bit:+
04/05/18 16:34:05 SessionMgr(11824): Connection success for the external process
'eWkspace'
04/05/18 16:36:50 SessionMgr(11824): ERROR:
erdas::viewlayer::features::FeaturesViewLayer::FeaturesViewLayer: Unspecified
exception: erdas::viewlayer::features::FeaturesContext::Initialize
04/05/18 16:37:07 SessionMgr(11824): ERROR:
erdas::viewlayer::features::FeaturesViewLayer::FeaturesViewLayer: Unspecified
exception: erdas::viewlayer::features::FeaturesContext::Initialize
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+Session log 64-bit:+
04/05/18 16:38:29 SessionMgr(7800): Connection success for the external process
'eWkspace_64'
04/05/18 16:39:27 SessionMgr(7800): ERROR:
????????????????????????????????›???????????????????????????????????
???????
IM-44635

ERDAS IMAGINE
crashes with
model containing
Convert To
Surface Operator.

1. Launch ERDAS IMAGINE 2018
2. Load the attached model in the Spatial Model Editor.
3. Provide the input as cities.shp and provide the output location
4. Execute the model
5. After executing try to open the output file from File open > Recent
6. Observe ERDAS IMAGINE crashes.
Event log:
Faulting application name: eWkspace.exe, version: 16.5.0.230, time stamp:
0x5af0744a
Faulting module name: eraster.dll, version: 16.5.0.327, time stamp: 0x5aeccb04
Exception code: 0xc000041d
Fault offset: 0x00000000000bec73
Faulting process id: 0x35a8
Faulting application start time: 0x01d3e79bbe79c81a
Faulting application path: C:\Program Files\Hexagon\ERDAS IMAGINE
2018\bin\x64URelease\eWkspace.exe
Faulting module path: C:\Program Files\Hexagon\ERDAS IMAGINE
2018\bin\x64URelease\eraster.dll
Report Id: ba99353d-538f-11e8-83a9-b8ca3a86789b
Faulting package full name:
Faulting package-relative application ID:

IM-44692

ERDAS IMAGINE
crashes with
model containing
Point Cloud
Encode operator

1. Launch ERDAS IMAGINE 2018
2. Launch Spatial Model Editor
3. Open the model encode.gmdx
4. Provide the inputs
* Fritz-fails.hpc
* 1815subset-small.img
* Build selection criteria from enquire box as shown in figure
5. Click on preview and observe ERDAS IMAGINE crashes
Expectation: Being a not proper input for Raster Input (it has no overlap with the point
cloud), software shouldn’t crash - proper error message expected.

IM-44326

Output format for
LasValidate
operator is not
correct

1.
2.
3.

Launch Spatial Model Editor.
Drag and drop the lasvalidate operator in the Spatial Model Editor.
Double click the OutputFilename port of the operator.

IM-44325

LasView operator
does not work

1.
2.
3.

Launch Spatial Modeler.
Drag and drop lasview operator in the spatial modeler editor.
Give any las file as input and run the operator.
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IM-44324

LasClip operator
does not work

Data: LAS file and the corresponding shapefile in the attached zip file
1. Launch Spatial Modeler.
2. Drag and drop the lasclip operator in the spatial modeler editor.
3. Give the las file and shapefile in the attached zip file as inputs to the lasclip
operator.
4. Give the output filename and execute the operator.
Notice that there is a following message and the output is not generated.

IM-43998

LASColor operator
does not work

After configuring the LASTools, from the spatial modeler execute the lascolor
operator with the appropriate outputs. Notice that there is no output generated.
* In ERDAS IMAGINE 2016 v16.1, the operator shows that it has run successfully but
the output isn't generated.
* In ERDAS IMAGINE 2018 v16.5, the following message is shown in the spatial
modeler and the output is not generated.
lascolor.exe: process exited with non-zero code 1
The standalone lascolor.exe and the same option from the ribbon UI works fine and
an output is generated.

IM-43964

Output file
extension for
lasinfo operator
should be txt

This is an issue with LASTools for ERDAS IMAGINE 2016 v16.1 also.
1. Drag and drop lasinfo operator.
2. Double click on the OutputFilename port.
Note - in file chooser that opens, the files of type are LAS or LAZ. Whereas the output
of lasinfo should be txt similar to the same option from the ribbon LASTools tab.

IM-44632

Creating a vector
output within
Spatial Modeler on
German OS will
truncate float
attribute values

Customer found that they still face the point-comma decimal separator issue when
creating floating point attribute values on a German OS.
Customer's model will compute the compactness for polygons and write this values
into a attribute column of a new output shape. The values are correct within the model
(multiply and select by attribute works correct). But as soon as the customer writes
the floating point values into a file, the values are truncated. This only happens if they
do set comma as decimal separator which is the default setting on a German OS.
Customer confirmed that if they run the model via run model command (which means
in the background) the values are saved correctly. If they run it directly within the
Spatial Modeler, the values are truncated.
1. Set decimal separator to " , " or locale to German
2. Load and run model inside the Spatial Model Editor
Open attribute table of the newly created file: 0.0000 is in the compactness column.

IMAGINE EXPANSION PACK – AUTOSYNC
Issue ID
IM-39847

Summary –
IMAGINE
AutoSync

Description / How to Reproduce

AutoSync takes
too long to
compute active
area

The process of computing the active area is too slow in AutoSync. Running APM with
input and reference images that are both uncompressed IMG/IGE files around 3.5 GB
each takes approximately three hours. Both the input and reference images have
pyramid layers and are unsigned 8-bit.
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It appears to be the computing active area that is taking so long, the tie point creation
is quite fast. When loading the same images into MosaicPro and computing the active
area with an edge boundary search it only takes a few seconds. The input image is
18447 x 42312 and the reference image is 18526 x 35326.
IM-43935

AutoSync Edge
Match generated
incorrect
calibrated results

When displaying the calibrated edge match result images (wasia1_mss_output.img
and wasia2_mss_output.img) together in the Viewer, only the first image is visible.
NOTE: The resampled Edge Match results are correct. Only the calibrated ones have
problem.

IM-43870

Processing of
APM takes a lot of
time on AutoSync
2016 compared to
earlier versions

Customers have reported that when using ERDAS IMAGINE 2016, the Autosync
product can take a very long time to run the Automated Point Matching (APM)
process to find common control points between the two images being matched. The
time taken has increased significantly over previous versions of the software. The
problem was found to be related to the process of computing the active area of the
input imagery (e.g. if the input images had significant areas of background data,
calculating the locations of the true image edges was taking too long).
The solution was to use the same fast edge-detection algorithm as had been
introduced into MosaicPro.

IMAGINE EXPANSION PACK – DELTACUE
Issue ID
IM-43143

Summary –
IMAGINE
DeltaCue

Description / How to Reproduce

DeltaCue Help:
compactness
formula
documented
incorrectly

OLH documentation uses incorrect equation for compactness calculation
Filtering Unwanted Change Concept topic
C=A/P1*P2
Where:
A = region area
P1 = major axis of that region
P2 = minor axis of that region
As the change region grows longer in one dimension, the compactness tends to
decrease. A perfectly square area would have a compactness of one.
DeltaCue uses isoperimetric quotient, the ratio of the area of the shape to the area of
a circle (the most compact shape) having the same perimeter, to measure the
compactness. So the formula C=A/P1*P2 is not correct. The correct one is
C=A*Pi*4.0/(P*P), where A is the shape area, Pi is about 3.14, P is the shape
perimeter. Using the above formula, the compactness of a square is about 0.785 and
0.142 for a rectangle with the ratio of its sides 1:20.
Change from: A perfectly square area would have a compactness of one.
Change to: A perfectly circular area would have a compactness of one.
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IMAGINE EXPANSION PACK – NITF
Issue ID

Summary –
IMAGINE NITF

IM-44570

Deadlock in lggibiif

IM-44041

Cannot open NITF
images with a
colon in IID1 field

Some new NITF data uses a colon in the IID1 field, like so - PIXQLA:002. IID1 is used
by the NITF library as part of the name for the SBI file. When you try to open this data
in ERDAS IMAGINE, it throws error messages about illegal characters (the position
indicator corresponds to where the colon is) and it won't load.

IM-43324

Unable to display
NITFs with invalid
characters in Text
Segments

ERDAS IMAGINE 2018
Attempting to open the image in a 2D View (as raster, not ImageChain) fails. You get
a whole _ton_ of errors in the Session Log, no pixels are displayed, and the title bar is
empty, although the file name is shown in the Table of Contents.
ImageInfo crashes when trying to open these images.
Similar errors to those above when using these images in a Raster Input or opening
them in an ImageChain.

IM-43368

Opening a specific
NITF file as Image
Chain fails and
registers series of
errors in session
log
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Description / How to Reproduce

1.
2.
3.

Click File > Open > Raster as Image Chain.
Browse to /2004-dg-0000187-1
Select 03DEC04074120-M2AS_R1C1-000000098060_01_P001.NTF and click
Open.
4. Image fails to load in the viewer and throws error dialogs as shown in
attachments
5. Session log records the following:
12/02/18 17:29:58 SessionMgr(14132): Connection success for the external process
'eWkspace_64'
12/02/18 17:31:46 SessionMgr(14132): ERROR: #142 from biifFileOpen
12/02/18 17:31:46 SessionMgr(14132): ERROR: DataSet::Open failed
12/02/18 17:31:46 SessionMgr(14132): ERROR: #355 from DataSet::Open
12/02/18 17:31:46 SessionMgr(14132): ERROR: Unparsed cached item.
12/02/18 17:31:46 SessionMgr(14132): ERROR: #142 from biifFileOpen
12/02/18 17:31:46 SessionMgr(14132): ERROR: DataSet::Open failed
12/02/18 17:31:46 SessionMgr(14132): ERROR: #355 from DataSet::Open
12/02/18 17:31:46 SessionMgr(14132): ERROR: Unparsed cached item.
12/02/18 17:31:46 SessionMgr(14132): ERROR: #142 from biifFileOpen
12/02/18 17:31:46 SessionMgr(14132): ERROR: DataSet::Open failed
12/02/18 17:31:46 SessionMgr(14132): ERROR: #355 from DataSet::Open
12/02/18 17:31:46 SessionMgr(14132): ERROR: Unparsed cached item.
12/02/18 17:31:46 SessionMgr(14132): ERROR: #142 from biifFileOpen
12/02/18 17:31:46 SessionMgr(14132): ERROR: DataSet::Open failed
12/02/18 17:31:46 SessionMgr(14132): ERROR: #355 from DataSet::Open
12/02/18 17:31:46 SessionMgr(14132): ERROR: Unparsed cached item.
12/02/18 17:31:53 SessionMgr(14132): ERROR: #44 from
erdas::phoenix::coverage::ImageIdentifiersRequestCachedData::ImageIdentifiersReq
uestCachedData
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12/02/18 17:31:53 SessionMgr(14132): ERROR: eimg_FileImageNamesGet failed
12/02/18 17:31:53 SessionMgr(14132): ERROR: #14930 from
eimg_FileImageNamesGet
12/02/18 17:31:53 SessionMgr(14132): ERROR: eimg_FileOpen failed
12/02/18 17:31:53 SessionMgr(14132): ERROR: #5968 from eimg_FileOpen
12/02/18 17:31:53 SessionMgr(14132): ERROR:
//alpha/array4/datalibrary/quickbird/middle_east/iraq/2004-dg-00001871/03dec04074120-m2as_r1c1-000000098060_01_p001.ntf: eimg_FileOpen failed
(33:Unsupported Raster format or non-Raster format)
12/02/18 17:32:06 SessionMgr(14132): ERROR: #579 from
erdas::rendering::imagechain::ImageChainBroker::FindProvidersForDataset
12/02/18 17:32:06 SessionMgr(14132): ERROR: `anonymousnamespace'::GetResponse failed
12/02/18 17:32:06 SessionMgr(14132): ERROR: #49 from `anonymousnamespace'::GetResponse
12/02/18 17:32:06 SessionMgr(14132): ERROR: eimg_FileImageNamesGet failed
12/02/18 17:32:06 eimg_FileOpen failed
12/02/18 17:32:06 //alpha/array4/datalibrary/quickbird/middle_east/iraq/2004-dg0000187-1/03dec04074120-m2as_r1c1-000000098060_01_p001.ntf: eimg_FileOpen
failed (33:Unsupported Raster format or non-Raster format)
12/02/18 17:32:06 SessionMgr(14132): ERROR: #196 from `anonymousnamespace'::GDSHandlerEIMG::OpenDataset
12/02/18 17:32:06 SessionMgr(14132): ERROR: eimg_FileOpen failed
12/02/18 17:32:06 SessionMgr(14132): ERROR: #5968 from eimg_FileOpen
12/02/18 17:32:06 SessionMgr(14132): ERROR:
//alpha/array4/datalibrary/quickbird/middle_east/iraq/2004-dg-00001871/03dec04074120-m2as_r1c1-000000098060_01_p001.ntf: eimg_FileOpen failed
(33:Unsupported Raster format or non-Raster format)
12/02/18 17:32:16 SessionMgr(14132): ERROR: #1269 from setupDefaultChain
12/02/18 17:32:16 SessionMgr(14132): ERROR: ImageChainLayer::GetProviderList
failed
12/02/18 17:32:16 SessionMgr(14132): ERROR: #1378 from
ImageChainLayer::GetProviderList
12/02/18 17:32:16 SessionMgr(14132): ERROR: Unable to open image; the file may
be invalid.
12/02/18 17:32:16 SessionMgr(14132): ERROR: #142 from biifFileOpen
12/02/18 17:32:16 SessionMgr(14132): ERROR: DataSet::Open failed
12/02/18 17:32:16 SessionMgr(14132): ERROR: #355 from DataSet::Open
12/02/18 17:32:16 SessionMgr(14132): ERROR: Unparsed cached item.
12/02/18 17:32:16 SessionMgr(14132): ERROR: #142 from biifFileOpen
12/02/18 17:32:16 SessionMgr(14132): ERROR: DataSet::Open failed
12/02/18 17:32:16 SessionMgr(14132): ERROR: #355 from DataSet::Open
12/02/18 17:32:16 SessionMgr(14132): ERROR: Unparsed cached item.
12/02/18 17:32:19 SessionMgr(14132): ERROR: #196 from `anonymousnamespace'::GDSHandlerEIMG::OpenDataset
12/02/18 17:32:19 SessionMgr(14132): ERROR: eimg_FileOpen failed
12/02/18 17:32:19 SessionMgr(14132): ERROR: #5968 from eimg_FileOpen
12/02/18 17:32:19 SessionMgr(14132): ERROR:
//alpha/array4/datalibrary/quickbird/middle_east/iraq/2004-dg-0000187-
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1/03dec04074120-m2as_r1c1-000000098060_01_p001.ntf: eimg_FileOpen failed
(33:Unsupported Raster format or non-Raster format)
12/02/18 17:32:34 SessionMgr(14132): ERROR: #241 from
OpenURICommand::Execute
12/02/18 17:32:34 SessionMgr(14132): ERROR: `anonymousnamespace'::GetResponse failed
12/02/18 17:32:34 SessionMgr(14132): ERROR: #49 from `anonymousnamespace'::GetResponse
12/02/18 17:32:34 SessionMgr(14132): ERROR: eimg_FileOpen failed
12/02/18 17:32:34 //alpha/array4/datalibrary/quickbird/middle_east/iraq/2004-dg0000187-1/03dec04074120-m2as_r1c1-000000098060_01_p001.ntf: eimg_FileOpen
failed (33:Unsupported Raster format or non-Raster format)
IM-35856

Investigate SxS
error logs reported
by CSM

SxS errors appear in the log. It has been mentioned that these are innocuous, but we
should attempt to eliminate them so that we will know that we will be properly alerted
when there actually is a problem. They look similar to the following:
“C;\ProgramData\Hexagon\GeoService Backend
2016\csmplugincache\x64release\2010\lggicsmv3.dll: context creation failed (14001):
The application has failed to start because its side-by-side configuration is incorrect.
Please see the application event log or use the command-line sxstrace.exe tool for
more detail.”

IM-44557

ewkspace hangs
at #200 when
opening 306
NITFs with RSETs

Copy specific NITF-JPEG images locally, making sure that there are RSETs (.r1, .r2,
.r3, & .r4) for each .ntf.
Attempt to open all 306 NITF files in a 2Dview.
1. Open ewkspace (do not use an instance of ewkspace where you have
previously opened a NITF)
2. File | Open | Raster Layer
3. Select the first NITF and then shift-select the last NITF
4. Click OK
In the bottom left corner of ewkspace you will see "Opening 1 of 306:"... When it gets
to "Opening 200 of 306" ewkspace will hang.

IMAGINE EXPANSION PACK – STEREOSAR DEM
Issue ID
IM-12386

Summary –
IMAGINE
StereoSAR DEM

Description / How to Reproduce

StereoSAR DEM
module producing
incorrect results
with example data.

Customers have reported that when using ERDAS IMAGINE 2016, the StereoSAR
DEM tool no longer produces acceptable output DEMs compared to previous
versions.
The problem was inadvertently introduced via a change to the way coordinates are
referenced in "raw" satellite imagery which was not taken into account in the
StereoSAR DEM tool. This meant that control points were not being correctly related
to their image position.
The solution was to correct StereoSAR DEM to use the newer coordinate referencing
system.
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ERDAS IMAGINE INSTALLATION
Summary –
ERDAS IMAGINE
Installation

Description / How to Reproduce

IM-43118

Help - Minor
corrections are
needed in
IMAGINE Online
help

ERDAS IMAGINE 2018
In the topic Installing Microsoft® System CLR Types for Microsoft SQL Server, there
is a statement as follows:
 Follow these instructions to install Microsoft® System CLR Types for Microsoft
SQL Server (2008 R2 and 2014 versions) for accessing features through
*Oracle Feature Proxy (*.OFP)* in the Viewer and SME.
In the statement "Oracle Feature Proxy (*.OFP) *should be replaced with SQL
Feature Proxy (*.SFP)*
In another page (Installing Oracle Data Access Components), in Step 3, for both 32bit installer & *64-bit installers* change directory is mentioned as 32-bit installer.
 *"Change directory to the folder where the 32-bit installer is unzipped."*
 For 64-bit installer, it should be mentioned as
 *"Change directory to the folder where the 64-bit installer is unzipped."***

IM-42807

Borrowing only
Essentials would
borrow Advantage
and Professional

ERDAS IMAGINE 2018
1. Launch the borrowing tool.
2. Select either *IMAGINE Essentials and Add-Ons* or *IMAGINE Essentials*.
3. Click the Borrow button.
4. Once the license is borrowed, remove the machine from LAN.
5. Launch IMAGINE.
Notice in the nagging dialog there are modules other than only Essentials listed in
there showing that they are also borrowed even though they weren't selected while
borrowing. After ERDAS IMAGINE launch, cross checked the modules that require
Advantage and Professional and they were launching.

IM-43747

Cannot uninstall
LASTools

In the Configure Extension dialog, clicking Remove after selecting the
LAStoolsForIMAGINE_Extension.xml opens an error and the uninstallation fails.

IM-23053

Configure
Extensions - Not
transparent if
configuration has
succeeded

When configuring LASTools it is not so transparent if the configuration has succeeded
or not. The process is so fast it sometimes appears to have done nothing.
Also, because IMAGINE has to be re-started for the configuration to take effect, it is
good to open a message that says "Configuration Succeeded. Restart IMAGINE for
the configuration to take effect"

Issue ID
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ABOUT US
Hexagon Geospatial helps you make sense of the dynamically changing world. We enable you to envision,
experience and communicate location intelligence. Our technology provides you the form to design, develop
and deliver solutions that solve complex, real-world challenges. Ultimately, this is realized through our
creative software products and platforms.
CUSTOMERS. Globally, a wide variety of organizations rely on our products daily including local, state and
national mapping agencies, transportation departments, defense organizations, engineering and utility
companies, and businesses serving agriculture and natural resource needs. Our portfolio enables these
organizations to holistically understand change and make clear, reliable decisions.
TECHNOLOGY. Our priority is to deliver products, platforms and solutions that make our customers
successful. Hexagon Geospatial is focused on developing technology that displays and interprets information
in a personalized, meaningful way. We enable you to transform location-based content into dynamic and
useable business information that creatively conveys the answers you need.
PARTNERS. As an organization, we are partner-focused, working alongside our channel to ensure we
succeed together. We provide the right platforms, products, and support to our business partners so that they
may successfully deliver sophisticated solutions for their customers. We recognize that we greatly extend our
reach and influence by cultivating channel partner relationships both inside and outside of Hexagon.
TEAM. As an employer, we recognize that the success of our business is the result of our highly motivated
and collaborative staff. At Hexagon Geospatial, we celebrate a diverse set of people and talents, and we
respect people for who they are and the wealth of knowledge they bring to the table. We retain talent by
fostering individual development and ensuring frequent opportunities to learn and grow.
HEXAGON. Hexagon Geospatial is part of Hexagon, a leading global provider of information technology
solutions that drive productivity and quality across geospatial and industrial landscapes. Hexagon’s solutions
integrate sensors, software, domain knowledge and customer workflows into intelligent information
ecosystems that deliver actionable information. They are used in a broad range of vital industries.
Hexagon (Nasdaq Stockholm: HEXA B) has more than 18,000 employees in 50 countries and net sales of
approximately 4.2 bn USD. Learn more at hexagon.com and follow us @HexagonAB.
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Copyright
© 2018 Hexagon AB and/or its subsidiaries and affiliates. All Rights Reserved. Hexagon has registered trademarks in many countries
throughout the world. Visit the Trademarks Page for information about the countries in which the trademarks are registered. See
Product Page and Acknowledgements for more information.
Product Documentation Terms of Use
PLEASE READ THESE TERMS CAREFULLY BEFORE USING HEXAGON GEOSPATIAL’S DOCUMENTATION ("DOCUMENT"). USE
OF THIS DOCUMENT INDICATES ACCEPTANCE OF THIS AGREEMENT WITHOUT MODIFICATION. IF YOU DO NOT AGREE TO
THE TERMS HEREOF ("TERMS"), DO NOT USE THIS DOCUMENT.
Use Of This Document
All materials in this Document are copyrighted and any unauthorized use may violate worldwide copyright, trademark, and other laws.
Subject to the terms of this Agreement, Hexagon Geospatial (a Division of Intergraph Corporation) and Intergraph’s subsidiaries
("Intergraph") hereby authorize you to reproduce this Document solely for your personal, non-commercial use. In consideration of this
authorization, you agree to retain all copyright and other proprietary notices contained therein. You may not modify the Materials in any
way or reproduce or publicly display, perform, or distribute or otherwise use them for any public or commercial purpose, except as
specifically authorized in a separate agreement with Hexagon Geospatial.
The foregoing authorization specifically excludes content or material bearing a copyright notice or attribution of rights of a third party.
Except as expressly provided above, nothing contained herein shall be construed as conferring by implication, estoppel or otherwise any
license or right under any copyright, patent or trademark of Hexagon Geospatial or Intergraph or any third party.
If you breach any of these Terms, your authorization to use this Document automatically terminates. Upon termination, you will
immediately destroy any downloaded or printed Materials in your possession or control.
Disclaimers
ALL MATERIALS SUPPLIED HEREUNDER ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, OR NON-INFRINGEMENT. Hexagon Geospatial does not warrant that the content of this Document will be
error-free, that defects will be corrected, or that any Hexagon Geospatial Website or the services that make Materials available are free
of viruses or other harmful components.
Hexagon Geospatial does not warrant the accuracy and completeness of this Document. Hexagon Geospatial may make changes to this
Document at any time without notice.
Limitation Of Liability
IN NO EVENT SHALL HEXAGON GEOSPATIAL BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR
CONSEQUENTIAL DAMAGES, OR DAMAGES FOR LOSS OF PROFITS, REVENUE, DATA OR USE, INCURRED BY YOU OR ANY
THIRD PARTY, WHETHER IN AN ACTION IN CONTRACT OR TORT, ARISING FROM YOUR ACCESS TO, OR USE OF, THIS
DOCUMENT.
Indemnification
You agree to defend, indemnify, and hold harmless Hexagon Geospatial, its officers, directors, employees, and agents from and against
any and all claims, liabilities, damages, losses or expense, including reasonable attorneys’ fees and costs, arising out of or in any way
connected with your access to or use of this Document.
Use Of Software
Use of software described in this Document is subject to the terms of the end user license agreement that accompanies the software, if
any. You may not download or install any software that is accompanied by or includes an end user license agreement unless you have
read and accepted the terms of such license agreement. Any such software is the copyrighted work of Hexagon Geospatial, Intergraph
or its licensors. Portions of the user interface copyright 2012-2018 Telerik AD.
Links To Third Party Websites
This Document may provide links to third party websites for your convenience and information. Third party websites will be governed by
their own terms and conditions. Hexagon Geospatial does not endorse companies or products to which it links.
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Third party websites are owned and operated by independent parties over which Hexagon Geospatial has no control. Hexagon
Geospatial shall not have any liability resulting from your use of the third party website. Any link you make to or from the third party
website will be at your own risk and any information you share with the third party website will be subject to the terms of the third party
website, including those relating to confidentiality, data privacy, and security.
Trademarks
The trademarks, logos and service marks ("Marks") displayed in this Document are the property of Hexagon Geospatial, Intergraph or
other third parties. Users are not permitted to use Marks without the prior written consent of Hexagon Geospatial, Intergraph or the third
party that owns the Mark. "Intergraph" is a registered trademark of Intergraph Corporation in the United States and in other countries.
Other brands and product names are trademarks of their respective owners.
Find additional trademark information.
Procedure For Making Claims Of Copyright Infringement
Notifications of claimed copyright infringement should be sent to Hexagon Geospatial by mail at the following address: Intergraph
Corporation, Attn: Intergraph Legal Department, P.O. Box 240000, Huntsville, Alabama 35824.
US Government Restricted Right
Materials are provided with "RESTRICTED RIGHTS." Use, duplication, or disclosure of Materials by the U.S. Government is subject to
restrictions as set forth in FAR 52.227-14 and DFARS 252.227-7013 et seq. or successor provisions thereto. Use of Materials by the
Government constitutes acknowledgement of Hexagon Geospatial or Intergraph’s proprietary rights therein.
International Use
You may not use or export Materials in violation of U.S. export laws and regulations. Hexagon Geospatial makes no representation that
Materials are appropriate or available for use in every country, and access to them from territories where their content is illegal is
prohibited.
Hexagon Geospatial provides access to Hexagon Geospatial international data and, therefore, may contain references or cross
references to Hexagon Geospatial products, programs and services that are not announced in your country. These references do not
imply that Hexagon Geospatial intends to announce such products, programs or services in your country.
The Materials are subject to U.S. export control and economic sanctions laws and regulations and you agree to comply strictly with all
such laws and regulations. In addition, you represent and warrant that you are not a national of, or otherwise located within, a country
subject to U.S. economic sanctions (including without limitation Iran, Syria, Sudan, Cuba, and North Korea) and that you are not
otherwise prohibited from receiving or accessing the Materials under U.S. export control and economic sanctions laws and regulations.
Hexagon Geospatial makes no representation that the Materials are appropriate or available for use in every country, and access to
them from territories where their content is illegal is prohibited. All rights to use the Materials are granted on condition that such rights are
forfeited if you fail to comply with the terms of this agreement.
Revisions
Hexagon Geospatial reserves the right to revise these Terms at any time. You are responsible for regularly reviewing these Terms. Your
continued use of this Document after the effective date of such changes constitutes your acceptance of and agreement to such changes.
Applicable Law
This Document is created and controlled by Hexagon Geospatial in the State of Alabama. As such, the laws of the State of Alabama will
govern these Terms, without giving effect to any principles of conflicts of law. You hereby irrevocably and unconditionally consent to
submit to the exclusive jurisdiction of the United States District Court for the Northern District of Alabama, Northeastern Division, or the
Circuit Court for Madison County, Alabama for any litigation arising out of or relating to use of this Document (and agree not to
commence any litigation relating thereto except in such courts), waive any objection to the laying of venue of any such litigation in such
Courts and agree not to plead or claim in any such Courts that such litigation brought therein has been brought in an inconvenient forum.
Some jurisdictions do not allow the exclusions or limitations set forth in these Terms. Such exclusions or limitations shall apply in all
jurisdictions to the maximum extent allowed by applicable law.
Questions
Contact us with any questions regarding these Terms.
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